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THE LEARNING COMPANY LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS CAREFULLY BEFORE USING THIS
PROGRAM.

This Agreement governs your use of the The Learning Company products enclosed with it
including any manuals, disks, computer program and materials associated with it (the
“Software”).  BY OPENING THE SEALED PACKAGES CONTAINING THE DISKS
AND/OR BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS
OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, PROMPTLY RETURN THE UNOPENED DISK PACKAGES TO THE
PLACE YOU OBTAINED THEM FOR A FULL REFUND.

1.  Grant of License.  This Agreement permits you to use one copy of the Software, which is
licensed as a single product.  The Software is “in use” on a computer when it is loaded into
the temporary memory (i.e., RAM) or installed into the permanent memory (e.g., hard disk
or other storage device) of that computer.  You may use the Software on a network provided
you have purchased one copy for each user.

2.  Copyright and Restrictions.  The Software is owned by The Learning Company, Inc. or
its suppliers and is protected by United States and Canadian copyright laws and international
treaty provisions.  The Learning Company, Inc. retains all rights not expressly granted.  You
must treat the Software like any other copyrighted material, except that you may either make
one copy of the Software solely for backup or archival purposes or transfer the Software to a
single hard disk provided you keep the original solely for backup or archival purposes.  You
may not rent or lease the Software, but you may transfer your rights under this Agreement on
a permanent basis provided you transfer the license granted by this Agreement, the Software
and all associated printed materials, retain no copies and the recipient agrees to the terms of
this Agreement.  You may not reverse engineer, decompile or disassemble the Software,
except to the extent the foregoing restriction is expressly prohibited by applicable law.

3.  Limited Warranty.  For 90 days from your date of purchase, The Learning Company,
Inc. warrants that the media on which the Software is distributed are free from defects in
materials and workmanship.  The Learning Company, Inc. will, at its option, refund the
amount you paid for the Software or repair or replace the Software provided that (a) the
defective Software is returned to The Learning Company, Inc. or an authorized dealer within
90 days from the date of purchase and (b) you have completed and returned the enclosed
registration card.  These are your sole remedies for any breach of warranty. The Learning
Company, Inc.  disclaims all other warranties, either express or implied, with respect to
the Software and the accompanying written materials, including but not limited to
implied warranties of merchantability and fitness for a particular purpose.

4.  Limitation of Liabilities.   In no event will The Learning Company, Inc.  be liable for
any indirect, special, incidental, economic or consequential damages arising out of the use or
inability to use the Software, even if The Learning Company, Inc. has been advised of the
possibility of such damages.  In no event will The Learning Company, Inc.’s  liability exceed
the amount paid by you for the Software.  Because some jurisdictions do not allow the
exclusion or limitation of liability for consequential or incidental damages, the above
limitation may not apply to you.

5.  U.S. Government Restricted Rights.  The Software is are provided with RESTRICTED
RIGHTS.  Use, duplication or disclosure by the Government is subject to restrictions as set
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software—Restricted Rights at 48 CFR 52.227 - 19, as applicable.  Manufacturer
is The Learning Company, Inc.  International Inc., 201 Broadway, Cambridge, MA  02139
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Note to Users

End users may print and sell hard copies (not electronic copies) of the
calendars as long as the following notice appears:  “Calendar created
with Calendar Creator 5.0  ©1997 The Learning Company, Inc.”
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Welcome to Calendar Creator™

Calendar Creator is the most powerful calendar creating and scheduling software
available today!  This fun and easy-to-use program now gives you the ability to
completely personalize your calendar by providing endless formatting options that
include hundreds of fonts; color, border, and shading options; free movement of all
calendar cells; seven calendar layouts; hundreds of graphics; and a variety of
printing options that let you decide how your calendar should be laid out. In
addition, Calendar Creator now provides you with an electronic Address Book
where you can store all of your business and personal contact information, and a
fully functional Event List where you can add and maintain all of your scheduled
events.

These new features, along with the many outstanding features that have already
made Calendar Creator the world’s most popular program year after year, give
you the ability to create unique, professional-quality calendars that will help you to
stay on schedule and stay organized.

What’s New in Calendar Creator

Calendar Creator has a new look, quicker methods of entering events on your
calendar, and many more enhancements to give you the most powerful and
versatile calendar-creating program ever.  The following list highlights some of
these enhancements and new features.

Address Book

3 enables you to keep your important numbers and addresses close to your
schedule

3 can be used to send e-mail to people listed in your Address Book

3 can be used to direct-dial numbers on your Address Book

3 can be customized to list only specific information in your Address list
screen

3 provides several ways of sorting and searching your Address Book

3 can associate people listed in your Address Book into a group, such as a
softball team, e-mail the entire group at once



1 - 2               Calendar Creator User’s Guide

Calendars

3 allow all cells and fields to be set as “moveable” and placed anywhere on
your screen

3 allow new color and font options, including special effects

3 allow new border and shading options

3 allow new graphics that can be placed anywhere on your calendar

3 can create individual calendars for specific needs

3 allow multiple calendars to be stored in one easy to retrieve file

Event Lists

3 allow event information to be entered directly into your Event List

3 categorize events according to your needs

3 sort events in a variety of ways

3 allow you to add event notes, which are indicated on both your Event
List and your calendar by a note-like icon

3 allow event participants to be selected from your Address Book

Printing

3 includes the Print Wizard feature to assist you in setting up print layouts

3 allows easier poster and InstaBook™ printing

3 can specify the size of your calendar(s) on a page

3 can specify the time period to be included in your printed calendar

3 can print graphics with your calendar

Miscellaneous

3 can change your screen view at the click of one button

3 can modify your graphics using the Clip Art screen

3 can share calendars over a network

3 includes password protection to control shared information

3 works with US Robotics PalmPilot™

3 can import or export event or address files

3 can link and update linked event files
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Features of Calendar Creator

Calendar Creator has more capabilities than any other calendar program.  The
following is a listing of some of these features.

• You can fully customize your calendars by adding shading, borders,
pictures, and various fonts.

• You can add pictures and special effects.

• It offers multiple printing options including single calendar on multiple
pages, multiple calendars on a single page, and double-sided InstaBook
pages.

• It allows you to determine the time span of your calendar (from one day
to multiple years).

• It allows several calendars to be stored in a single file and be given
individual names.

• It offers seven basic calendar layouts including; day, weekly planner,
week, multi-week, month, multi-month, year, and multi-year.

• You can print calendars on a variety of paper sizes and stocks.

• The printing options let you decide how many calendars to print per page
and the time span of each printed calendar.

• It offers InstaBook printing, which creates a small booklet-type calendar.

• It has split-screen window options that allow you to view your calendar
and Event List simultaneously.

• You can track repeated events for days, months, and years and indicate
any exceptions to the repeat.

• It includes several pre-made Event Lists such as, the list of holidays,
quotes of the day, and Hollywood stars’ birthdays.

• It has over 5,000 clip art pictures.
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How to Use this Manual

This manual is designed to provide easy-to-follow and easy-to-find information on
how to use Calendar Creator.  It is written with the general assumption that you
are familiar with the basic operation of Windows.  Therefore, it does not explain
features that are common to Windows-based programs.  If you are unfamiliar with
Windows, please refer to your Microsoft® Windows® User’s Guide and familiarize
yourself with the general terminology, layout, and navigation of the Windows
operating system.  Understanding and being comfortable with Windows is essential
to learning and fully utilizing the features of Calendar Creator.

This manual is composed of the following chapters.

• Chapter 1, Welcome to Calendar Creator, provides an overall
introduction to Calendar Creator.

• Chapter 2, Getting Started, explains how to load your new software, as
well as the general terminology used in this manual and the layouts of
the main Calendar Creator screens.

• Chapter 3, Creating Your Calendar, explains how to select your
calendar’s time span, how to add style to your calendar, and how to store
your calendars.

• Chapter 4, Adding Events to Your Calendar, explains how to use Event
Lists to manage your scheduled events.

• Chapter 5, Using the Address Book, explains how to record personal and
business contacts, as well as link these contacts to your calendar’s
events.

• Chapter 6, Printing Your Calendars, explains how to setup the printing
options to print single-page and multi-page calendars, as well as
InstaBooks™.

Typographical Conventions
Here are a few useful notes about the terms, typographical conventions, and
symbols used in this manual.  The following symbols indicate the specific nature
of the text that immediately follows the symbol.

• This solid bullet indicates general list information.

o This checkbox symbol indicates instructional information.  This action-
oriented text is set in a different font than other text and usually requires
you to interact with Calendar Creator using the keyboard or mouse.

! This pencil symbolizes highlighted notes, helpful hints, and strategies for
using the software.

M This bomb symbolizes warning text and is set in bold.  Ignoring this
information could result in adverse effects.
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Key Names and Combinations
The names of keys and onscreen function buttons are set in SMALL CAPITAL LETTERS.
For example, ESCAPE, ENTER, OK.  Some key names on your keyboard may be
represented a little differently.

Calendar Creator is a Windows-based program.  Thus, it is designed to work using
either the keyboard or the mouse.  Instructions in this manual typically assume that
you are using the mouse to make your selections from menus, dialog boxes, etc.
However, most actions can be performed using the keyboard only.  You’ll notice
on all of the menus that one letter is underlined in each menu item.  Pressing the
ALT key on your keyboard while simultaneously typing this underlined letter will
allow you to select that item.  You can also use the arrow keys on your keyboard to
move up or down and left or right in lists.

The right-mouse button is often used in Calendar Creator to provide quick access
to certain functions such as cut, paste, properties, etc.

Finding Help!
Calendar Creator provides online Help for each major function and for many of
the controls and individual fields.  There are three levels of Help.

• The first level is the most basic and provides help for general Windows
commands and for the major functions of Calendar Creator.  It is
accessed from the Help main menu located at the top of your screen, or
by selecting the Help icon ( ) on the main toolbar.

• The second level provides basic information on specific screens and
dialog boxes for Calendar Creator.  It is accessed by selecting the HELP

button that appears on most screens and dialog boxes.

• The third level provides detailed information for specific fields and keys
on the dialog boxes and screens.  It is accessed by selecting the question
mark icon (?) that appears in the top-right corner of most dialog boxes
and screens.
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Useful Terms and Definitions

Calendar Cells All calendars are comprised of many different cells.  Each cell
can contain its own format settings, text, and graphics.

Calendar View In Calendar Creator, this term refers to the time periods
presented by a calendar.  Examples of calendar views include
Year, Month, Multi-Month, Week, Multi-Week, Week Planner,
and Day.

Drawing Object Graphic cells that can be added to your calendar in the form of
various shapes.  Pictures can be added to these cells—sized and
moved as you wish.

Event List Customized lists containing the events and their information
that are marked on your calendar(s).

Event View One of the views offered by Calendar Creator.  This view
shows only the events belonging to the active calendar.

InstaBook™ A printing option that automatically determines the placement
of multiple calendars on a page so that when cut, folded, and
stapled, a booklet-type calendar is produced.

Moveable Cells Calendar Cells that can be moved anywhere on your calendar
screen.  Calendar Cells are set as moveable using the
“Moveable” field on the Style tab.

QuickStyles™ Pre-formatted calendar styles that are based on a specific theme
such as Art Deco, Hollywood, Christmas, etc.  QuickStyles can
also be user-defined to save your favorite calendar creations.

Text Boxes Cells that are added to calendars specifically to contain text.
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Getting Started

Installing Calendar Creator is a quick and easy process.  Simply follow the
instructions provided on your screen as you are loading this software, to ensure
that it is properly installed.  This will help to avoid application problems in the
future. Calendar Creator is designed to run on a personal computer that meets or
exceeds the following system requirements.

• Microsoft® Windows® 95/NT installed and running

• 486 processor, 33 MHz

• double-speed CD-ROM drive (or better)

• 8MB of RAM (16MB recommended)

• 256 color video card, thousands of colors recommended (16 bit)

Installing Calendar Creator

Calendar Creator can be installed using the AutoRun feature that is automatically
activated when you insert the CD-ROM into your computer’s drive.  Simply
follow the onscreen instructions to successfully install Calendar Creator.
Remember to register your copy of Calendar Creator in order to receive
notification of updates and new releases, access technical support, and get
information about other software available from The Learning Company.

o Insert the Calendar Creator CD-ROM into your CD-ROM drive.

o The start-up mode will be automatically initiated.  If it fails, position the
cursor on the Start icon in the Task Bar, then click the mouse button once.
Select the Run option from the menu.

You will see a dialog box similar to the one shown below.

Run Dialog Box
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o Type in D:\SETUP.EXE, where D represents the letter for your CD-ROM
drive.  Click on the OK button.

The system will begin installing Calendar Creator.  Follow the onscreen
instructions.  During installation, you are given the opportunity to install all of
Calendar Creator or just various portions that you need.  If you are limited by the
amount of space available on your hard drive, you may want to refrain from
loading and storing the clip art that is included with this software.  These can still
be accessed when needed by inserting your Calendar Creator CD-ROM in your
drive.

You are also given the opportunity to install Calendar Creator in the default
directory (C:\…\Creative Office\Calendar Creator) or select another directory.
Use the Browse feature to select another directory, if desired.

Once Calendar Creator in successfully loaded on your computer, you will be
given the option to restart Windows.  You must restart Windows before using
Calendar Creator.  Once restarted, the Calendar Creator icon will appear in the
Start menu under “Creative Office.”

o Select Programs from the Start menu on your task bar.  Then, select the
Calendar Creator option from the Creative Office item.

To register your Calendar Creator program later:

Double-click on the Register icon in the “Creative Office”  folder on your hard
drive and follow the onscreen instructions using † to move from field to field.

The Basics

When you access Calendar Creator, the default calendar will be in view.  Before
you begin to use this calendar, continue reading to familiarize yourself with the
basics of the Calendar Creator desktop environment.

Screen Definitions for Calendar Creator

Upon opening Calendar Creator for the first time (and any time thereafter when
you create a new calendar), you will see the default initial view of Calendar
Creator (shown labeled in the following figure).  This default view is the Month
calendar view.  As you customize your calendar and record your events, this initial
screen will probably no longer resemble your actual calendar(s).
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Definition of Typical Calendar Creator Screen

The commands and controls that allow you to manipulate Calendar Creator are
listed in either the Main Menu or are accessed using the Toolbar buttons that
appear on your screen underneath the main menu.  Each of these is discussed
below.

MAIN MENU HEADINGS

The Main Menu located at the top of your Calendar Creator screen contains the
following menu items:  File, Edit, View, Calendar, Events, Address, Window, and
Help.  Each of these main items contains various submenus that are accessed by a
drop-down list.  Submenus are accessed by clicking on the main menu item using
the mouse or by pressing the ALT key while at the same time typing the underlined
letter in the item name.

MAIN TOOLBAR ICONS

The Main Toolbar buttons allows you to quickly perform certain functions;
typically with one click of the mouse button.  As with most Windows-based
applications, you can reposition the toolbars to place them at the top, bottom, or
either side of your screen by dragging them to the desired position while the cursor
is positioned on the double-bars located to the left of the tool bar set.  You can also
select which toolbars you want to view (Main, Navigation, and Format) using the
Show Toolbars item under the View main menu.  This same menu item allows you
to view the toolbar buttons as large or small icons.  Each default toolbar button and
its function are described below.

Opens the New dialog box, allowing you to open a new calendar
document

Active view
type indicator

Calendar type
indicator

Main Menu
headings

Main Toolbar
icons

View next or
previous time
period

View your
Address
Book

Go to today’s
date cell

Access the
QuickDate
dialog box

View your
Event List
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Activates the Open dialog box, allowing you to open a calendar file

Saves the active calendar file

Access the printing dialog box to initiate printing

Cuts (removes) the selected item and copies it to the clipboard

Copies the selected item to the clipboard

Pastes the selected item from the clipboard to the selected area in
your document

Launches context technical help

Launches the Internet Browser and accesses the TLC Home Page

Used to Zoom In and Out, respectively

Used to add picture box for graphics

Used to add a note box

Used to draw an object with text effects

Used to quickly add an event

Splits the window view

Allows you to quickly find an address

The remaining toolbar buttons access specific features.  Each is discussed in the
following.
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CALENDAR TYPE INDICATOR

Calendar Creator allows you to work with several different calendars in one file.
This field indicates the name of the specific calendar currently in use.  Calendars
are created by selecting the Add Calendar item under the Calendar main menu
located at the top of the screen.  The Add Calendar dialog box appears and is used
to name the new calendar, indicate the event categories that will be included in the
calendar, and indicate the views that will apply to this new calendar.  As you create
new calendars, they are listed in the Calendar Type drop-down list that is
accessible from this field.

CHANGING THE TIME PERIOD OF YOUR CALENDAR

Each calendar view displays a certain amount of time (i.e., a Month, a Week, a
Day, etc.).  This amount of time is called a period.  The period displayed by each
of the calendar views can be changed using  the left- and right-arrow navigation

buttons ( ) located in your toolbar.  For example, if you are currently
viewing a Month calendar showing February, selecting the left arrow button will
result in the Month calendar showing January.  Likewise, if you are viewing a
Week calendar showing 1st through 7th, selecting the right arrow button will shift
the dates displayed by one week (e.g., 8th through 15th).

In addition to using these arrow buttons to shift a calendar period, you can also use
the “Go to Today’s Date” or  “Select a Date” ( ) buttons.  When you click on
the “Go to Today’s Date” button, the calendar view will be adjusted to include
today’s date.  When you activate the “Select a Date” button, the Quick Date dialog
box (shown below) will appear.  (This button also appears on various Calendar
Creator dialog boxes.)

Quick Date Dialog Box

This feature is allows you to adjust your calendar dates to a specific time.  Select
the time using one of the three following methods.

Go forward a monthGo back a month

Go back a year Go forward a year
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• The “In” field located above the displayed calendar can be used to
indicate the number of increments to move the date (e.g., 3).  The field
beside this is used to define the increments (e.g.,␣ months).

• The two double arrows beside the month header can be used to change
the calendar view to same month of the next year (double arrows
pointing to the right) or the same month of the previous year (double
arrows pointing to the left).  The inside arrows can be used to change the
view to the next month (right arrow) or previous (left arrow) month.

• The mouse can be used to select from the displayed calendar a date of
interest.  The calendar view, in return, will display the time period
containing the date.

! These buttons are active only when one of the seven calendar views is in
the active screen.  They are shaded grey when the Address Book, Event
List, or Clip Art screens are active.

When your calendars are more than one page in length, the “Display Next Page”
and “Display Previous Page” buttons can be used to shift your page view.

QUICK SELECTION OF ACTIVE VIEW

Three toolbar buttons are provided that allow you to quickly change your active
view to either Address Book, Event List, or Calendar.  These are controlled by the
Address, Event, and Calendar icons, respectively.

    

ACTIVE VIEW INDICATOR

This field indicates the View (or type) of the active screen.  The active view can be
one of the following:

• one of the seven calendars (year, month, multi-month, week, multi-week,
weekly planner, or day)

• the Address Book

• the Event List

• the Clip Art screen

Each of these options is selected from the drop-down list accessible from this
“View Type” indicator field or from the View Main Menu item located at the top of
your screen.  The two figures show examples of a Calendar view versus an Event
List view.  Notice the active View Type indicator in each figure.
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Day Calendar View as Active View

Event List as Active View

Choosing a Window Display/Using a Split-Screen View

One of Calendar Creator’s most useful features is its ability to display multiple
screens simultaneously (e.g.,␣ your Calendar and Event List).  The Split-Screen
option is controlled from the Window main menu item or by activating the split-
screen button in your toolbar.  The window option contains several screen options
that enable you to view multiple calendars and/or windows.  When using a split-
screen view, you’ll notice a double-line bar that controls the size of the windows.
When you move the cursor across this double-line bar using the mouse, the pointer
will turn from an arrow to double-dashes with small arrows jutting from the top and
bottom.  When the cursor is in this position, you can click the mouse button and
drag this split-screen bar up or down.

Calendar Type
indicator field

View Type
indicator field
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Sharing Your Calendar Creator Files on a Network

Calendar Creator makes is easy to share your calendar files that are stored on a
server.  Once Calendar Creator is installed on your network, each user must run
N:/SETUP.EXE, where N represents the drive letter of your server.  This installs
the system files and updates the .ini file with references to the network.

! Similarly, there is a file called N:/UNSETUP.EXE, where N represents
the drive letter of your server, that can be used to uninstall the program.

The program does not offer any file protection beyond that which is available on
the network.  The network administrator is responsible for assigning read and write
privileges for these shared files.

To open an Event List on the server:

o Use standard Windows techniques to locate the network drive and open
the file.  If you open an Event List as read-only, you can make temporary
changes, but you cannot save the changes to that particular file.

Working with shared Event Lists or calendars that contain pictures is equally as
simple; however, the actual picture file is not saved with the file.  Instead, the path
to that file is saved (i.e., linked).  As long as the file remains in that location, you
can access it when you open the Event List or calendar file.  If the picture file has
been moved, a warning message will appear when you open the file.

Opening Event Lists Created in Previous Versions
Calendar Creator 5.0 allows you to open an Event List created in a previous
version of Calendar Creator (2.0, 3.0, or 4.0).  You can select to either keep the
style of each event as formatted in the previous version, or have the format of the
first event applied to all events from the previous version.

To open an Event List created in a previous version:

o Select Open from the File main menu.  Then, select the file type to be
opened from the Files of type drop-down menu, and select the file to be
opened from the Open dialog box.  Click on the OPEN button.   (To save the
new file as a CC5.0 file, see Chapter 3, Saving Your Calendar File.)

Linking Files vs. Importing Files
When using Calendar Creator, it is important that you understand the difference
between linked files and imported files.  Linking files simply inserts a path to the
specific file.  If the file is moved to another location and the path changes, the file
will no longer be linked.  A warning message informs you of the change.  The path
will have to be adjusted to re-link the new file.  Importing files, on the other hand,
actually brings the data from the file into a Calendar Creator format.  That file can
then be saved in a Calendar Creator file.
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Understanding this information is important because Calendar Creator gives you
the means to import Event Lists, Address Books, and PalmPilot™ files, or to link
Event Lists.  Each of these topics is discussed in the following.

Importing Files
Event List, Address Book, and PalmPilot files can be imported using the Import
item listed under the File main menu.

To import a file:

o Select the Import item from the File main menu.  Then, select the type of
file to be imported (events, addresses, or “Pilot” files).

! “Pilot” files are those created using the PalmPilot system.

o The standard Windows Open File box will appear.  Use this box to locate
your file, then select OK to import the file.

To export a file:

o A file is exported using the same technique as above, but instead of
selecting the Import menu item, select the Export menu item from the File
main menu.

IMPORTING A FILE INTO A NEW OR EXISTING FILE

Calendar Creator 5.0 event files (*.cc5) can be imported into a new or existing
Calendar Creator 5.0 file.

To import a new or existing file:

o Select the Import item from the File menu, then select Event from the
drop-down menu.  Select the file type to be opened from the Files of type
menu, and select the file to be opened from the Open dialog box.  Click on
the OPEN button.  (To save the new file as a CC5.0 file, see Chapter 3,
Saving Your Calendar File.)

IMPORTING *.CSV FILES FROM OTHER APPLICATIONS

Event Lists that were created in other applications using the comma separated value
(*.csv) format, can be imported using the Import command under the File menu.

To import *.csv files into your Event List:

o Select Import from the File menu.  Then, select Event from the drop-down
menu and select (*.csv) as the file type to be imported.
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! If an Event List is currently open when using the Import feature, the file
being imported will merge with the file currently open, creating a single
Event List file when saved.

The Import Fields dialog box will appear.  This dialog is used to assign properties
to each field being imported into the Event List.

o Select the first checkbox to convert any special DOS-based characters
that are contained in the file being imported.

o Select the second checkbox to have the first line of the file imported as a
header.

o Assign each field in the imported file to an Event List field by clicking on
the column header labeled, “Unassigned,” and select the Event List field
from the drop-down list.  Then, click on the OK button.   (To save the new
file as a CC5.0 file, see Chapter 3, Saving Your Calendar File.)

LINKING EVENT FILES

Calendar Creator allows you to link event files.  This is useful when event files
are shared over a network.  When a file is linked, it can be seen (and in some cases
modified) by those who have been given access to file directory.  It is recommend-
ed that only one person make modifications to the event file at a time.  This will
ensure that each person who has linked the file to their application will receive all
updated modifications.

To link a file:

o Select the Link Event Files item from the File main menu.

The Linked Event Files dialog box appears showing any previously linked files.

o To link a new file, activate the ADD button.  The standard Windows Open File
box will appear.  Use this box to locate your file, then select OK to link the file.

Linked files can be set to update automatically using the Preference dialog box.
This box is accessed by selecting the Preferences item from the File main menu.
The “Update Network Event Lists” field can be checked to automatically update
the files.  The “every X minutes” field is used to indicate how often the files
should be updated.

You can also manually update the shared files by selecting the Update Linked
Events item from the File main menu.

To delete a linked file:

o Activate the DELETE button from the Linked Event Files dialog box while the
file is selected in the list.
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Creating Your Calendar

Calendar Creator provides many enhanced formatting controls.  Virtually every
inch of your calendar can now be customized!  You can add pictures; add and
modify text styles, size, and color; add borders and shading; manipulate date
ranges; reposition all cells, apply and create QuickStyles, create multiple calendars
in one file—this list could go on and on.  The focus of this chapter is to introduce
you to all of these formatting controls and to help you get started in producing
professional looking, unique—and most importantly—useful calendars.

Creating a New Calendar File

When you initially open the Calendar Creator program, a new (General) calendar
in the Month view displays on your screen.  This default calendar view can be used
as a starting point to create your calendar.  It is considered as a calendar file and is
given a name when you save it.  New calendar files can be created at any time by
following these steps.

o You can create a new calendar file at any time by selecting the NEW item
from the FILE main menu located at the top of the screen.  You will be
prompted to save, if desired, any existing calendar files, which is done
using the standard Windows saving techniques (File/Save or File/Save
As).

A new calendar file will be initialized and the default calendar view (Month) will
again appear.  You can create a new calendar file at any time during the use of this
software by repeating these steps.

! It should be noted that you can save multiple calendars in one file.  Please
refer to the “Creating Multiple Calendars and Saving Your Calendars”
section to add new calendars to a file.

Selecting Your Calendar “View”
When using Calendar Creator, the term “view” refers to the time period shown on
a calendar.  Calendar Creator offers seven calendar views.  These are:  Year,
Month, Multi-Month, Week, Multi-Week, Weekly Planner, and Day.

The Month view is the default calendar view when creating new calendars, but this
can easily be changed as follows.
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To select your calendar view, you can either:

• select the desired view from the View main menu item located at the top
the screen, or

• select it from Active View Indicator field (see Chapter 2 for the location
of this field) at the top of your calendar screen.

The calendar views in the following figures show how the views would appear
without any customizations.

Month Calendar View (Default)

Year View
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Multi-Month View

Multi-Week View

Week View
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Weekly Planner View

Day View

o Select the desired calendar template from the View main menu item
located at the top of the screen or from the View Type indicator field (refer
to Chapter 2 for the location of this field).

! The Event List, Event Report, the Address Book, and a Clip Art screen,
also listed under the View main menu and the View Type indicator field,
are discussed in Chapters 4 and 5.

Once you have selected your calendar view, you are ready to begin utilizing the
formatting options!  The views provided with this software do not require changes
in order to serve as fully functional, attractive calendars.  They can be used “as is.”
However, as you become more familiar with Calendar Creator, you will probably
want to take advantage of all of its formatting capabilities.
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Applying a QuickStyle ™

Before diving into the formatting controls, you may want to look at Calendar
Creator’s QuickStyles.  QuickStyles are pre-formatted styles that can be applied to
any calendar view.  They are centered on various themes (e.g., Art Deco,
Hollywood, Halloween, Christmas, etc.) and include a variety of fonts and color
schemes.  These styles serve as great examples of the formatting possibilities
offered with Calendar Creator.

o Select the QuickStyle item from the Calendar submenu located at the top
of the screen.

The QuickStyle dialog box will appear and resemble the figure shown below.

QuickStyle Dialog Box Showing Sample Styles

The names of the QuickStyles are listed in the left side of the box.  As you scroll
down this list, a preview of the calendar style will be displayed in the right side of
the box.  This preview enables you to see what your calendar will look like before
applying a style.

o Choose your QuickStyle, then select the APPLY button.

Once you become familiar with the calendar formatting controls, you can create
your own QuickStyles to save and re-use your favorite calendar designs.  Refer to
the next sections for details.
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DEFINING YOUR OWN QUICKSTYLES

You can create your own QuickStyles to save your most creative and useful
calendar styles so they can be used time after time.

To add a QuickStyle:

o Select the QuickStyle item from the Calendar main menu located at the
top of the screen.  Then, select the ADD button from the QuickStyle dialog
box while your calendar design is in the active window.

The New QuickStyle dialog box will appear and resemble the figure shown below.

New QuickStyle Dialog Box Showing a Sample Calendar

o Next, select a calendar view from the drop-down list.  This view will
become the template for the QuickStyle.

Your customized calendar view will appear in the preview window.

o Enter the name of your new QuickStyle in the “New QuickStyle Name”
field.  Then, click on the SAVE button.

The New QuickStyle dialog box will close, and the name will be added to the
QuickStyle list.  It will remain in this list until it is deleted.

! You can delete a QuickStyle at any time by selecting the item in the list,
then activating the DELETE button in the QuickStyle dialog box.
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Customizing Your Calendar’s Appearance

Calendar Creator has more layout features than ever!  Virtually every aspect of
your calendar can be customized by using the drawing tools, adding pictures,
reformatting text, rotating text and pictures, applying borders, adding colors and
patterns, etc.

All calendars are segmented into “cells.”  Each cell represents a specific area of
the calendar to which formatting options can be applied.  Cells are distinguishable
only when they are “selected.”  When they are “selected,” dotted lines appear
around the cell area, as in the example shown below; the Month header is selected.

Calendar Showing the Month Title Field Selected

As you move your cursor around your calendar screen, you will notice that each
calendar consists of numerous cells.  In addition to these cells, you can add other
cells to your calendars using the picture and text placement features.  These are
discussed later in this chapter.

Formatting Features
To apply formatting features, access the Layout Object Properties dialog box by
selecting a cell area, then double-click on it, or right-click on it and select
Properties.  Depending on the calendar view and the cells selected, different
formatting tabs will appear in the Layout Object Properties dialog box.  Each tab is
discussed in detail in the following sections.

Adding Pictures and Drawing Objects
Pictures and drawing objects (rectangles, round rectangles, ellipses, or lines) can
be placed anywhere on your calendar.  This includes the background of your
calendar and inside specific cells.  Pictures are added using the Picture tab, which
can be accessed using any the following methods:
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• Select the Picture tab from the Layout Object Properties dialog box (by
double-clicking in an area where no text currently exists or that is not an
event cell).

• Select the Add Drawing Object item from the Calendar main menu, then
selecting the Picture item.

• Activate the Insert Picture icon ( ) in your main toolbar.

! You can also copy and paste pictures onto your calendar using the Clip
Art screen.  This process is discussed in the next section.

Using the Layout Object Properties dialog box will place the picture in the selected
cell.  Using the other methods will allow the picture to remain independent of any
field on the screen (i.e., it can be moved anywhere on the calendar).

o Using the mouse, select (or highlight) the area where the drawing object is
to be added (e.g.,␣ calendar cell).  If you are inserting a new cell (using the
Add Drawing Object method or Insert Picture icon), the cursor will change
from an arrow to a plus symbol (+).  Click and drag the plus symbol to
define the new cell area.

! You can position the picture cell anywhere on the calendar by making sure
that the “Moveable” field on the Style tab is checked.

Once you have selected or drawn an area, the Layout Object Properties dialog box
will appear.

Layout Object Properties Dialog Box Showing the Picture Tab with Pictures

o Select the Picture tab from the dialog box.
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! No picture files will be listed when you first access this tab.  As you import
these files, they will be added to the “Picture in this Calendar” list.

The first step to adding pictures to your selected area is to add pictures to the
“Picture in this Calendar” list.  This is done using the standard Windows Browse
feature (shown opened in the figure below) to scan your files.  Refer to your
Window user’s guide if you are unsure how to browse your files.

Open Dialog Box Used to Browse Files

o Browse your files to find a picture, then click on the OPEN button.

This will place the picture file in the “Pictures in this Calendar” list.

The “Time Period” field located at the top of this dialog box can be used to place
the picture next to an item in your Event List for a specified time period only.  This
field will be disabled if no time period applies.

As you select an image in your “Pictures in this Calendar” list, you can apply
formatting controls using the buttons located in the lower-left portion of the tab
and the check boxes located in the lower-right portion of the box.  The functions of
each button and box are described below.

• Rotate 90° will flip the image 90 degrees to the right.

• Save to Disk will prompt the file directory so the image can be saved as
a bitmap file.

• Flip Horizontally will flip the image to the left creating a mirror effect.

• Flip Vertically will flip the image upside down creating a mirror effect.

• Delete will remove the image from the “Pictures in this Calendar” list.
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• Purge will purge the previewed image and any formatting adjustments
made to it.

• Brightness will increase or decrease the intensity difference between the
lighter and darker elements of the image.

• Fit to Area is used to enlarge or shrink the image to fit the selected area
as much as possible while keeping the image’s original proportions
(Proportional), fill the entire area regardless of the proportions
(Complete), or leave the image as is (No change).  You can select only
one of these options at a time.

• Tile produces the picture as in a tile format.

• Center

! You can select either Tile or Center, but not both at the same time.
Likewise, you cannot select Tile if you have selected a Fit to Area option.

• Transparent allows you to select a color (e.g., background color) to
make transparent (i.e.,␣ remove from the picture).  To the left of this
toggle box is a field labeled “Transparent Color.”  The color displayed in
this field indicates which color is transparent.  To change the color, either
click on the  color field to retrieve the Color dialog box to select a color,
or click on the dropper icon, then point to the color in the previewed
picture that you want to be transparent.

• Link to the File allows you to save the file path (not the actual file) in
your calendar file.

M Pictures require a large amount of memory.  Saving them in your file
may slow the speed of your system as well as occupy a large amount
of your hard drive space.

The last formatting tool located between the buttons and check boxes is used to
pan around the image.  Hold down the mouse button and move the cursor to view
different parts of the image.

o Apply any formatting properties to the picture, then click on OK in the Add
Event dialog box to insert the image into your Event List.

! You can remove pictures from your calendar by selecting the picture, then
activating the DELETE button.

Adding drawing objects to your calendars is similar to adding pictures.  You
simply select one of the four drawing options: rectangle, round rectangle, ellipse,
and line.  They are listed under the Calendar main menu located at the top of the
screen.  The cursor will change from an arrow to a cross-like symbol (+).  Use this
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to define the new cell area by clicking and dragging the mouse.  It can be placed
anywhere on the calendar.

o Select (or highlight) the area where the drawing is to be added by
dragging the mouse to define the area.

Once you have placed your drawing object, you can apply various formatting
options using the Layout Object Properties dialog box and even add pictures inside
your drawing objects by following the above instructions.

Adding Clip Art
Calendar Creator provides over 5,000 clip art images.  These images can be
accessed using the Clip Art view, and then be copied and pasted to your calendar
files.

o Access the Clip Art view by either selecting the Clip Art item from the View
Main Menu located at the top of the screen or by selecting it from the
Active View Indicator field drop-down list.

The Clip Art screen will appear and resemble the screen shown in the figure below.

Clip Art View

Prior to opening your Clip Art folders, you can use the Clip Art Properties dialog
box to control the image sizes, spacing, etc.
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To access the Clip Art Properties dialog box:

o Select the Clip Art item from the Calendar main menu.  Then, select the
Properties item.

The Clip Art Properties dialog box will appear and resemble the figure below.

Clip Art Properties Dialog Box

The Default Width and Height settings are used to control the size of each clip art
image as it will appear on your Clip Art screen.  The Default Name Width and
Height settings control the size of the image’s name.  The Default Width and
Height Spacing setting control the amount of space between each image.  The Page
Width and Height setting control the size of the page on which the images are
displayed.

The “FONT FOR NAME” button accesses the Font dialog box, which can be used to
change the font of the image names as they appear on your Clip Art screen.

The “Include File Name” field can be checked to display the file name of each
image.

The “Save Pictures in File” field will import the folder to the Calendar Creator
program where it can be stored as a (*.ca5) file.

o Using the information above, make the necessary changes to the clip art
properties to alter the way the images appear on your Clip Art screen.
Then, save these settings by clicking on the OK button.

To access clip art images:

o Select the Clip Art item from the Calendar main menu.  Then, select the
Add Folder item.  If you want to add the folder, plus its sub-folders, select
the Add Sub Folders item.
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The Browse for Folder dialog box will appear.

o Using the standard Windows Browse method, search for the clip art file
you want to open.

The images from that folder will be placed on your Clip Art screen.  The images
that you want to appear on your calendar are added using the copy/paste method.

o Simply select the image in your Clip Art screen, then choose the Copy
item from the Edit main menu or click on the Copy icon in your main tool
bar.  View your calendar, then select Paste from the Edit main menu or
click on the Paste icon in your main tool bar.

The image will be pasted on your calendar screen.  Once it is pasted on your
calendar screen, it becomes part of that calendar file and can be manipulated using
the Layout Object Properties dialog box.

! The Line Up Objects item under the Clip Art menu can be used to align
multiple pasted images on your clip art screen.

! Imported clip art folders can be saved with a clip art extension (*.ca5)
by selecting the Save as Clip Art item from the Clip Art menu.

When you add clip art images to your calendar files, you are given the option of
making them transparent.  Selecting this option will adjust the images to appear
clear in certain areas (e.g., background), however, the clip art picture will remain
as is.  This will enable you to see both your calendar and your clip art image on the
same screen.

Adding Text to Your Calendar
Text is added to your calendar using the Text Box feature.  A Text Box is similar to
adding pictures in that you add a new cell to your calendar where poems, jokes,
etc., can be entered.  Text boxes differ from event text in that they may be
positioned anywhere on your calendar by clicking and dragging the cell to its
desired location.

To add a text box:

o Either select the Text item from the Calendar main menu located at the top

of the screen, or click on the Add Text ( ) icon in the main toolbar.

The cursor will change from an arrow to a plus symbol (+).  Click and drag the
plus symbol to define the new cell area.

o Insert the text box by clicking and dragging the mouse to define the text
area.
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A text box placeholder will appear on your calendar and the Text Object Properties
dialog box will open.  The figure below shows an example of a text box placeholder.

Portion of a Calendar Showing an Empty Text Box

To add text to an empty text box:

o Select the Text tab from the Text Object Properties dialog box.

! You can also access the Properties box by selecting the Properties item
from the Edit main menu located at the top of the screen while a text box
placeholder is selected.

The Text tab of the Text Object Properties dialog box will display.

Text Object Properties Dialog Box Showing the Text Tab

The “Text” field at the top of this tab is the where your text is entered.  As you type
in your text, it will display in the window in lower half of the tab.
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Applying Text Functions
Text functions are defined as the variable text that is supplied by the program to be
added to event descriptions and various calendar elements.  To further explain,
refer to this example.  If you apply the “&date” function to an event or text cell,
the date displayed will be proportional to the actual date.  If you switch the
calendar view using the previous or next period arrows, the date displayed will be
automatically adjusted.

The “Topic” field is used to select the text topic.  The “Function” field lists the
available functions that can be applied to the specific topic.  As you scroll through
each of the topics and functions listed, a complete description of its action will be
provided.  Use these descriptions as a guide to help you select the right function
for your needs.

o Once you have selected the topic and functions, apply them by activating
the PASTE FUNCTION button.  Then, save your changes by activating the OK

button.

Once you have entered you text, you can apply a variety of styling options using
the Style, Special Effects, Shadow/Highlight, Picture, and Repeats tabs.  These are
discussed in the following sections.

STYLE TAB

The Style tab is used to select your text style, color, and font; to apply borders and
shading; and set your text box as moveable.

! These instructions can also be used to modify the font of predefined text
cells (such as Month headers, etc.).

The “Moveable” field is used to set your text as moveable.  This means that when-
it is selected, you can click and drag the text around the screen.  If you don’t want
your text set as moveable, leave this field unmarked.

The Text Style options are located in the left portion of the Style tab and include
Justification, All Caps, and FONTS.

• Justification is used to position the text to the left, right, or center of the
cell.

• All Caps, when checked, will change the font to appear in ALL CAPITAL

LETTERS.

• The FONTS button is used to access the Font dialog box, which contains
the available fonts and font styles.

o To change the font, position the cursor on the FONTS button and click the
mouse button once.
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The Sample Font dialog box will appear and resemble the box shown.

Sample Font Dialog Box

The Sample Font dialog box operates as it does in other Windows-based
applications.

• Font lists the fonts available with Calendar Creator.

• Font Style lists the styles available with each font.

• Size lists the sizes available with each font.

• Effects allows you to add strike-out marks or underlines to the selected
font, as well as select the color of your text.

• Sample shows a preview of the selected font with the applied settings.

• Script lists the available language scripts for the specified font.

o Select the desired text settings, then save the changes by clicking on the
OK button.

The dialog box will close and the font and style will be applied to the text.

In the Text Object Properties dialog box, the Background options are used to add
background colors, and the Border options are used to add inside and outside
borders.
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• Shading is used to choose a pattern or a solid shade of the color
indicated in the “Shading” field.

• Color allows you to select the color of the area.

• Shape allows you to choose between a rectangle and a round rectangle as
the colored area.

• Show Shadow is used to add a shadow effect to the shaded area.

• The Inside Border and Outside Border options include border style and
color.

• Border Style is used to add an inside or outside (or both) border around
the selected area and to select the style of the border.

• Color is used to select the colors of the inside and outside borders.

The following figure shows an example of the selected month header with borders
and shading.

Example of a Month Layout with Shading and Inside and Outside Borders

o Using the controls described above, add shading, color, and borders to
your calendar or text.  Don’t be afraid to try any combination of formats.
When you have adjusted the borders, colors, and shading to meet your
specifications, apply the options to your calendar by selecting the OK

button in the Text Object Properties dialog box.
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SPECIAL EFFECTS TAB

The Special Effects tab is used to apply visual effects to your text.  For example,
you can select a thick font style, then fill it with a woven pattern or a picture.

Special Effects Tab

The Special Effects include the following controls that can be applied to the text.

• Fit to Shape is used to indicate the shape the text is to fill.

• Fill with Picture is used to add a picture to the font style.

• Fill with Pattern is used to add a pattern to the font style.

• Visual Effect allows you to add style to the text such as raised, sunken,
shadow, flying, or a custom effect.

• Color Scheme allows you to add patterns to the text (such as custom,
embossed, gold, steel).

• Auto Size automatically adjusts the text size to the text box.

• Text Wrap automatically wraps the text to the next line when the
sentence length is too long for the text box.

• Tile Picture box is used to apply a picture as a repeated pattern in the
letters.
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• Angle of Text is used to slant the text at a specified angle.

• Color Used for Pattern is used to apply the selected pattern to either the
shadowed area or the highlighted area of the text, or both areas.

o Using the information above, add the desired special effects to your text.
Click on the APPLY button to preview each formatting change before saving
it.  When you are satisfied with your effects, select the OK button.

SHADOW/HIGHLIGHT TAB

The Shadow/Highlight tab (shown below) can be used to add a shadow and/or
highlights to your text.

Shadow/Highlight Tab

The Shadow/Highlight tab contains the following options:

• Style is used to indicate the style of the shadow or highlight such as
Real, Extruded, or Graduated.

• Depth is used to indicate how deep you want the shadow and highlight
to appear.

• The Direction boxes are used to select the angle of the shadow or
highlight.

• Extrude fills in the area between the text and its shadow giving your text
a 3-D effect.



3 - 20               Calendar Creator User’s Guide

The rectangle area located to the right of the “Style” fields is used to select the
color of the shadow or highlight.  Simply click in the field to display the color
palette, then choose your color.

A preview of the styled text will display in the Preview area as each change is
made.

o Using the information above, add the desired shadows/highlights to your
text.  Click on the APPLY button to preview each change before saving it.
When you are satisfied with your changes, select the OK button.

PICTURES TAB

Adding pictures to your text boxes is similar to adding a picture to your calendar.
This feature is discussed in detail in the Adding Pictures and Drawing Objects
section of this chapter.  Please refer to this section for instructions on how to add
pictures to your text boxes.

REPEATS TAB

This section explains how to repeat text boxes on certain days or at certain times.
This is done using the Repeats tab of the Text Object Properties dialog box.

o Select the Event tab from the Text Object Properties dialog box.

The Repeats tab will resemble the screen shown below.

Text Object Properties Dialog Box Showing the Repeats Tab
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The first step to setting the repeat is to define the repeat occurrence rule.  This is
done by selecting one of the three repeat options or by manually entering the dates
in the “Start Date” field (indicates the date of the first occurrence of the event) and
the “Repeat Until” field (indicates the last day the event will be repeated).

! The icons beside each of these fields can be click ond to access the Quick
Date dialog box.  For further instructions on using this box, please refer to
Chapter 2, Getting Started.

If you choose to indicate the repeat dates using one of the three repeat options, the
lower half of the box changes according to the option selected.  Each is discussed
below.

• When you select the “Year, Month, Day” item, three columns will
display listing year numbers, month names, and days in dates (1–31).
Checking the “All Days,” “All Months,” or “All Years” items will select
all the times listed.

• When you select the “Year, Month, Week, Weekday” item, four columns
will display listing year number, month names, week numbers (1–5), and
day names (Monday through Sunday).  Checking the “All Days,” “All
Months,” or  “All Years” items will select all the times listed.

• When you select the third option; “Every,” three fields are displayed
prompting you to indicate increments of time (e.g., 4 months, 5 years, 2
days, etc.), and select which days, by date (1–31), you want to repeat in
the text box.

The right portion of the Repeats tab displays a Month calendar layout.  This
calendar is used to indicate any exceptions to the “Repeat Occurrence Rule.”
Exception dates are selected by clicking on the date in the calendar.  The dates are
listed in the drop-down menu of the “Exceptions” field.  If there are no exceptions
to the rule, this field remains set to the default value, “No Exceptions.”

You can change the month displayed using the arrows located on either side of the
month name.  The two single arrows change the calendar dates to the next (right
arrow) and previous (left arrow) month.  The two double arrows change the
calendar dates to the same month in the next (right arrows) or previous (left
arrows) year.

The “Weekend Occurrences” field is used to automatically move the text box to
another day when its repeated date falls on a weekend.  Possible options are
Monday, Friday, the closest weekday, delete the occurrence, or move all
occurrences to weekends only.

o Using the instructions above, set the text box to repeat as needed.  Then,
select the OK button to save the changes.
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Adding Notes to Your Calendar
Notes can be added to your calendar to display important information using the
Notes option.  Adding notes is similar to using text boxes in that they can be added
anywhere on your calendar.

To add notes:

o Select the Note item from the Calendar main menu or click on the Insert
Note icon ( ) in the main toolbar.

The cursor will change from an arrow to a plus symbol (+).  Click and drag on the
plus symbol to define the new cell area.

o Insert the note by clicking and dragging the mouse to define the note area.

The Notes box will appear on your calendar and the Formatting toolbar will open.
The Formatting toolbar is provided to give you a quick means of changing the
format of the note text.  The figure below shows an example of a note box and the
Formatting toolbar.

Calendar Showing a Note and Formatting Toolbar

Your notational text should be entered directly into the note cell.

! You can reposition your note in the calendar by selecting the note cell and
dragging the mouse.

o Enter the notational information and apply the desired formatting changes.
The Formatting toolbar will disappear when you position the cursor outside
the note box and click the mouse button.
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Adding Date Objects
Date Objects are appendage calendars that can be added to a calendar view.  These
Date Objects may consist of any one of the seven calendar views or a title, subtitle,
or footer cell.  The availability of each Date Object is dependent on the active
calendar view.  Date Objects are display only in events that can not be entered in
the individual calendar cells.

To add a Date Object to a calendar:

o Select the Add Date Object item from the Calendar main menu.  Then,
select the desired object to be added.

The cursor will change from an arrow to a plus  symbol (+).  Click and drag to
define the area for the new Date Object.

o Define the Date Object’s area by clicking and dragging the mouse.

When you release the mouse button, the Date Object will be placed on your
calendar (see the figure below).  You can adjust the size of the new Date Object at
any time, as well as place it anywhere on your calendar, by selecting the cell and
dragging the mouse.  In addition, you can add a style option, insert a picture, or
control the miscellaneous settings of the date object by double-clicking the mouse
button or by selecting the Properties item from the Edit main menu while the Date
Object is selected.

Calendar with a Date Object Inserted
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Determining Layer Orders
Layer orders are useful in situations where you have multiple calendars or cells
that overlap each other on you calendar screen.  For example, if you have added a
new Date Object or placed a picture on your calendar, you may find that they
overlap each other.  In such a case, you may use the Layer Order feature to
determine your actual view.

Four layer order options are offered: one level up, one level down, top level, and
bottom level.  Your use of these options will depend on how many cells you have
that overlap.

To apply a layer order option:

o Select the cell that you want to adjust, then choose the appropriate layer
order for the cell from the Layer Order menu item on the Calendar main
menu.

Continue to play with this feature until you have situated all of your cells as
desired.  The figure below shows an example of a picture that was placed on the
calendar, then given a “bottom level” layer order.

Calendar Showing Layers
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Viewing Your Calendar Pages

The View Pages feature, which is accessed from the Calendar main menu, can be
used to preview your calendar page, as well as to add or remove pages from your
calendar.

To access the View Pages feature:

o Select the “Pages” item from the Calendar main menu.

The View Pages dialog box will open displaying your calendar in the preview
window, as shown in the example below.

View Pages Dialog Box Showing a Sample Page

The function buttons located to the right of the previewed image are used to move
between pages (NEXT and PREVIOUS buttons) and add and remove pages.

o To add a calendar page, click on the ADD button.

When you do so, your preview window will close and a blank calendar page will
appear on the main screen.  This page can be used to:  add Date Objects, pictures,
text boxes, etc.  This gives you the ability to create multiple-page calendars in a
variety of styles.
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Changing Your Calendar’s Start Day
The Calendar Creator calendar views can be adjusted to begin on any day of the
week.  This is done using the Week Start Day feature.

To change the day of the week on which your calendar begins:

o Select the Week Start Day item from the Calendar main menu located at
the top of the screen.  Then, select the day of the week on which you
would like your calendar to begin.

All calendar views will be adjusted so that the day selected will be starting day of
each week.

To display weekdays only on your calendar:

o Choose “Weekdays only,” in the Calendar Type Indicator  window located
at the top-left of your calendar screen.  (See Chapter 2, Calendar Type
Indicator.)

Creating and Saving Multiple Calendars

As briefly explained at the beginning of this chapter, calendars are saved as
Calendar Creator files (*.cc5).  Multiple calendars can be saved as one file by
creating different calendar types.  Each calendar file can contain as many
individual calendars as you wish.  This enables you to save your Personal
Calendar, Business Calendar, and Holiday Calendar in one file (e.g., named “My
Calendars.cc5”).

Any time you access this “My Calendars.cc5” file, each individual calendar can be
viewed and modified by selecting it from the “Calendar Type” indicator field.

To create multiple calendars as one file:

o Select the Add Calendar item from the Calendar main menu item located
at the top of the screen.
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The Add Calendar dialog box will appear and resemble the following figure.

Add Calendar Dialog Box Showing the Calendar Style Tab

o Select the Calendar Style tab from the box.

! The Style tab can also be accessed by selecting the Calendar Properties
item from the Calendar main menu.  The settings you make are considered
the calendar’s properties.  The properties for each calendar you create
can be adjusted by selecting the Properties item from the Calendar menu.

The cursor position will default to the “Calendar Name” field.

o Enter the name of your calendar in this field.  You can apply a QuickStyle
to your new calendar, if desired, by selecting the style from the
“QuickStyle” list.

Once you have named your new calendar (and applied a QuickStyle, if desired),
select the categories that will be made available for the specific calendar.  This is
done using the Categories tab.

o Select the Categories tab from the dialog box.
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The Categories tab will appear and resemble the following figure.

Calendar Properties Dialog Box Showing the Categories Tab

All categories that have been previously defined will be listed on this tab.

To assign a category to the calendar:

o Select a category by placing a checkmark (3) in the box beside the item.
You can add a new category at any time by activating the ADD button, and
entering the new category name in the blank space provided in the list.
Be sure to place a “3” in the box beside the new item if you want it to be
available on your new calendar.

Next, you must select the calendar views (month, week, year, etc.) that will be
available for the new calendar.  This is done using the Calendar Views tab.

o Select the Calendar Views tab from the dialog box.
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The Calendar Views tab will appear and resemble the following figure.

Calendar Properties Dialog Box Showing the Calendar Views Tab

The seven calendar views and the clip art view will be listed in this tab.

To select a calendar view:

o Click on the ADD button while the cursor is positioned on the item.

The View Properties box will appear.  The View Properties dialog box is discussed
in detail in the following section.

Defining the View Properties
As you create your calendars, you may also define the calendars’ view properties.
This is done using View Properties dialog box.

To access the View Properties dialog box:

o Either select the ADD button from the Calendar Properties dialog box, or
select the View Properties item from the Calendar main menu.
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The View Properties dialog box will appear and resemble the figure below.

View Properties Dialog Box

The General tab will be displayed.  This tab is used to indicate the name of your
calendar and its type, as well as to control its viewing width and height.  Default
settings are provided by the software, however, they can be changed if needed.

The Facing Picture tab of the View Properties dialog box is used to add a facing
picture to your calendar.

o If you want to add a facing picture to your calendar, select the Facing
Picture tab and add the image, following the steps previously outlined in
the “Adding Pictures and Drawing Objects” section of this chapter.

The Object tab of the View Properties dialog box is used to control the placement
of your calendar objects, such as background, title, footer, inserted pictures, etc.
The “Visible” field is used to control the visibility of the selected object.  For
example, if you wanted to hide the footer of a calendar, you can remove the mark
from the “Visible” field.  The “X” and “Y” fields represent the placement
coordinates of the selected object.  The “Width” and “Height” fields control the
size of the selected object.

o Make any necessary adjustments to the objects that appear on your
calendar.

o When you are finished, click on the OK button to save your changes.
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Saving Your Calendar File
When you are satisfied with your calendar, you can save the file (containing as
many calendars as you wish) by following these steps.

o Select Save from the File main menu located at the top of the screen.
Then, indicate the location where you would like to save the calendar file
and enter the name you have assigned.

The calendar file will be stored as a (*.cc5) file.  All files can be retrieved at any
time using the standard Windows File/Open method.

SAVING A PREVIOUS VERSION FILE

When you open a file created in a previous version of Calendar Creator (2.0, 3.0,
or 4.0), you can now save it as a Calendar Creator 5.0 file.  (See Chapter 2,
Opening Event Lists Created in Previous Versions.)

To save a file created in a previous version:

o Open the file, then select Save from the File menu.  Enter the name the
new file will be saved under, select the location where you would like to
save the new calendar file, and click on the SAVE button.

THE AUTOSAVE FEATURE

This feature allows the program to automatically save a document at time-specific
intervals that you designate.  This helps to keep the document updated with the
latest changes, without requiring any further action by you.  The AutoSave feature
is located in the Preferences dialog box, which can be accessed using the
Preferences command located under the File menu.

Interaction Between Your Calendar and Event Lists
Once you have perfected the appearance of your calendar, you can begin to add
Events.  This is done using an Event List.  An Event List is simply a listing of the
information you want to display on your calendar.  Please refer to the next chapter
for complete information on using Event Lists to fully customize your calendars.
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Creating a Custom View

Besides using the default view available in Calendar Creator, you can create your
own custom views to reflect your personal needs.

To create a custom view:

o Select the Calendar Properties command from the Calendar main menu.
When the Calendar Properties dialog box appears, select the Calendar
Views tab.  Click on the ADD button and the View Properties dialog box will
appear.

o In the View Properties dialog box, name your custom calendar view, select
the view your custom view will be based on (you can also remove views
you don’t need), set the height and width of your custom view, and add
facing pictures, if any, that you would like to associate with your custom
view.  Click on OK to save your selections.

When the Calendar Properties dialog box reappears, you will now see the name of
your custom view in the list of available views.  You can use the Calendar Style
and Categories tabs to set the style, name, QuickStyle, and categories associated
with your new custom view.
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Adding Events to Your Calendar

Now that you’ve learned how to customize the appearance of your calendar, it is
time to begin using it!  Calendar Creator defines the information you want to
include on your calendar (such as birthdays, appointments, holidays, etc.) as
“Events.”  Events are added to your calendar using an “Event List.”  An Event List
is simply a file containing your events that is saved with your calendar(s).  A new
event list can be created with each new calendar to group your various types of
events such as business events and social events.  Doing so allows you to create
customized calendars for specific purposes.

Accessing the Event List

An Event List can be accessed in a variety of ways.

To access the Event List, choose one of the following methods:

• Select the Event View item from the Events main menu.

• Select the Event List item from the View main menu.

• Select the Event List item  from the Active Screen Indicator field drop-
down list.

• Click on the Event List icon ( ).

The Event List will appear and resemble the figure shown below.

Example of an Event List
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The Event List is comprised of the Display Event check box, an icon representing
the event category, and the event information.

The Display Event check box allows you to choose to display an event on your
calendar (the default) or to remove the event from the calendar without removing it
from the list.

The Category icon represents the event category.  It will appear here if you have
selected a predefined category or if you have assigned an icon to a your own
defined category.  (Creating categories is discussed in Creating and Maintaining
Event Categories.)  The icon can be used to quickly access the associated Event
Dialog Box by clicking the mouse button while the cursor is positioned in the icon
field.

The Event Information fields are used to enter and display information
concerning your events.  This information can be entered using the Add Event
dialog box, or it can be entered directly onto your Event List in the appropriate
field.  Each field is briefly explained below and explained in detail in the sections
that follow as they pertain to the functions and features discussed.

• Description displays brief information about the event.

• Category indicates the type of the event (e.g., general, meeting, birthday,
holiday, etc.).  Event Categories are user-definable.

• Priority indicates the priority of the event in relation to the other events
listed.

• Start Date indicates the date the event begins.

• Start Time indicates the time when the event begins.

• End Time indicates the time when the event ends.

• Attributes indicate if a note or an alarm has been associated with the
event.

• Participants lists people in your Address Book who are participating in
the event.
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Creating and Maintaining Event Categories
Before you begin adding your event information, you may want to set up a few
features to suit your needs.  The first of these is the Event Categories.  Calendar
Creator provides you with basic event categories such as Birthdays, Anniversaries,
To Do, and Meetings, etc.  If you want to add your own category, such as Business
Appointment or School Assignment, follow the steps outlined in this section.

You can create an unlimited number of categories for each calendar. For example,
your Work Calendar could include categories such as Meetings, To Do, Deadlines;
and your Social Calendar could include categories such as Birthdays, Dinner
Dates, Baseball Schedule, Weddings, etc.

o To create custom categories, select the Categories item from the Events
main menu.

You will see the Categories dialog box, as shown below, with sample categories.

Categories Dialog Box

o Select the ADD button, then position the cursor in the “New Category” field
and click the mouse button once to select the text.  Modify the field to
display the name of your new category.

If you want to apply formatting features, enable an alarm, or add pictures to events
that fall within this category, you can do so using the PROPERTIES button.  It
accesses the Style, Alarm, and Picture tabs (each tab is discussed below).  When
you apply properties to an event category, these properties are automatically
assigned to the events that comprise the category.

! You can delete a category type by selecting it in the list, then activating the
DELETE button.
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ASSOCIATING A SPECIFIC STYLE TO A CATEGORY

The Style tab of the Categories dialog box is used to format the event text and add
effects.

o Select the PROPERTIES button on the Categories dialog box, then select the
Style tab.

The Text Style options are located in the right portion of the Style tab and include
Justification, All Caps, and a FONTS button.

• Justification is used to position the text to the left, right, or center of the
cell.

• All Caps, when checked, will change the font to appear in ALL CAPITAL

LETTERS.

• The FONTS button is used to access the Font dialog box, which contains
the available fonts and font styles.

The Event Effects portion of this tab allows you to indicate whether the text should
be placed on your calendar as a Box Event or a Banner Event.  The “Shading” and
“Color” fields are used to add shading and color to the event text.  A preview of
your customized text style will appear in the “Sample” area as you make changes.

o To change the font, position the cursor on the FONTS button and click the
mouse button once.

The Font dialog box will appear and resemble the figure shown below.

Font Dialog Box
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This dialog box operates as it does on other Windows-based applications.

• Font lists the fonts available with Calendar Creator.

• Font Style lists the styles available with each font.

• Size lists the sizes available with each font.

• Effects allows you to add strikeout marks or underlines to the selected
font, as well as select the color of your text.

• Sample shows a preview of the selected font with the applied settings.

• Script lists the available language scripts for the specified font.

o Select the desired settings, then save the changes by clicking on OK.

The dialog box will close, and the selected font and style settings will be
associated with the specified category.

ASSOCIATING AN ALARM TO A CATEGORY

The Alarm tab is used to play a sound, launch an application, or compose a
message that will indicate the occurrence of a specific event.  Calendar Creator
operates in conjunction with Calendar Creator Scheduler when using alarms.
Therefore, please refer to the Using the Scheduler to Activate Your Alarms section
of this chapter for more information on how this process works.

o Select the PROPERTIES button on the Category Properties dialog box, then
select the Alarm tab.

The Alarm tab will appear and resemble the figure shown below.

Category Properties Dialog Box Showing the Alarm Tab
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When you first access this screen, the Alarm settings will be disabled.  You must
select the “Alarm” option to activate them.

o Select the “Enable Alarm” option to enable the alarm settings

Once the settings are enabled, you can indicate using the “Hrs” and “Mins” fields
when in relation to the event date/time you want the alarm to occur.  These fields
work in conjunction with the “Before Event” or “After Event” fields to set the
actual alarm time.

o Indicate the time when the alarm should occur.

Three different types of  alarms can be set:  Sound, Launch, and Message.  Sound
will produce a noise at the time of the event.  Launch will cause a specified
program application to be launched at the time of the event.  Message will produce
a user-defined message across your screen at the time of the event.  You can select
apply one, two, or all three of these types of alarms.

To set the Sound alarm:

o Select the alarm by placing an “X” in the “Alarm Sound” field.  Then, use
the standard Windows Browse feature to select the sound file that will be
used.  (If you are unsure of how to use the Browse feature, please refer to
your Windows Users Guide for instructions.)  Once you have linked the
sound file, you can test it by activating the TEST button.

To set the Launch alarm:

o Select the alarm by placing an “X” in the “Alarm Launch” field.  Then, use
the standard Windows Browse feature to select the program to be
launched when the event occurs.  (If you are unsure of how to use the
Browse feature, please refer to your Windows Users Guide for
instructions.)  Once you have linked the program file, you can test it by
activating the TEST button.

To set the Message alarm:

o Select the alarm by placing an “X” in the “Alarm Message” field.  Then,
simply enter the text that you would like to appear on your screen when
the event occurs.

ASSOCIATING PICTURES WITH A CATEGORY

The Pictures tab is used to provide the link between pictures and a category.

o Select the PROPERTIES button on the Category Properties dialog box, then
select the Pictures tab.
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The Picture tab will resemble the figure shown below.

Properties for General Dialog Box Showing the Picture Tab

! No picture files will be listed when you first access this tab.  As you import
these files, they will be added to the “Pictures in this calendar” list.

Pictures are added to the “Pictures in this calendar” list by using the standard
Windows Browse feature (shown opened in the figure below) to scan your files.
Refer to your Windows user’s guide if you are unsure of how to use this feature.

Open Dialog Box Used to Browse Files

o Browse your files to find your pictures, then click on the OPEN button.



4 - 8               Calendar Creator User’s Guide

This will place the picture file in the “Pictures in this Calendar” list.

The “Time Period” field located at the top of this box can be used to place the
picture next to the item on your event list for a specified time period only.

The image selected in your “Pictures in this Calendar” list can be formatted using
the buttons located in the lower-left portion of the tab and the check boxes located
in the lower-right portion of the box.  The functions of each button and box are
described below.

• Rotate 90° will flip the image 90 degrees to the right.

• Save to Disk will prompt the file directory so the image can be saved as
a bitmap file.

• Flip Horizontally will flip the image to the left creating a mirror effect.

• Flip Vertically will flip the image upside down creating a mirror effect.

• Delete will remove the image from the “Pictures in this Calendar” list.

• Purge will purge the previewed image and any formatting adjustments
made to it.

• Brightness will increase or decrease the intensity difference between the
lighter and darker elements of the image.

• Fit to Area is used to enlarge or shrinks the image to fit the selected area
as much as possible while keeping the image’s original proportions
(Proportional), to fill the entire area regardless of the proportions
(Complete), or leave the image as is (No change).  You can only select
one of these options at one time.

• Tile produces the picture as in a tile format.

• Center places the picture in the center of the selected area.

! You can select either Tile or Center, but not both at the same time.
Likewise, you cannot select Tile if you have selected a Fit to Area option.

• Transparent allows you to select a color (e.g., background color) to
make transparent (i.e.,␣ remove from the picture).  To the left of this
toggle box is a field labeled “Transparent Color.”  The color displayed in
this field indicates which color is transparent.  To change the color, either
click the mouse button in the color field to retrieve the Color dialog box
to select a color, or click on the dropper icon, then point to the color in
the previewed picture that you want to be transparent.

• Link to the File allows you to save the file path (not the actual file) in
your calendar file.
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M Pictures require a large amount of memory.  Saving them in your file
may slow the speed of your system as well as occupy a large amount
of your hard drive space.

The last formatting tool located between the buttons and check boxes is used to
pan around the image.  Hold down the mouse button and move the cursor to view
different parts of the image.

o Apply any formatting properties to the picture, and then select the OK

button on the Add Event dialog box to associate the image with your
category.

ASSOCIATING CATEGORIES AND CALENDARS

Located to the left of each category listed in the Categories dialog box is a check
box.  Placing a check in this box associates the category with the active calendar.
Likewise, removing the check mark will disassociate the category and the active
calendar.

Once all categories have been associated with your calendar, categories are
assigned to events using the drop-down menu accessible from the “Category” field
on the Event List or from the Event tab of the Add Event Dialog box.

Adding Events to Your Event List
And now for the big moment…  You are ready to add your events to your calendar!
Events can be added to your calendars using either of two methods: You can add
them directly to your Event List (a new feature of Calendar Creator), or add them
using the Event tab of the Add Event dialog box.  This dialog box is accessed
either by selecting the ADD EVENT item from the Event main menu, by expanding an
event line in your list by clicking on the category icon, or by double-clicking the
mouse button while it is positioned on a calendar view screen.  This section
discusses each of these methods of entering events on your calendar.

To add events directly to the Event List:

o As you select a blank line in the Event List, your event text can be entered
directly in each field.  Press the TAB key to move between fields.

o Either select the Add Event item from the Events main menu, click the
mouse button once while it is positioned on the icon located on the far
right side of the Event List, or double-click the mouse button while it is
positioned in a time field of a calendar view.
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The Add Event dialog box will appear with the Event tab selected.  This tab is used
to add your event information.  You will notice that some of the fields in this box
are similar to those listed on the Event List.  When you enter information into
these fields, it is carried over to the list (and vice versa).

Add Event Dialog Box Showing the Event Tab

The “Description” field is used to enter a description of the event.  You can add as
much detail as you want in this field.  It will appear in an abbreviated form on the
Event List and on your calendar; the overflow information can be printed as an
additional page accompanying your calendar and/or your event list.

The “Start Date” field is used to indicate the starting date of the event.  This field
is automatically populated with the date currently selected on your calendar (or
today’s date).

The “Repeat Until,” “Repeat For,” and “Repeat  Rule” fields are used to repeat an
event at specified dates/times.  Repeated events can be entered using this method,
or they can be entered using the ADVANCED REPEATS RULE button, which is discussed
in detail in the “Repeating Events” section of this chapter.

o Enter the starting date of your event.  To select the date, you can access
the Quick Date dialog box by clicking on the box to the left of the date field.

o If you are repeating the event, set your repeat rule by selecting one of the
repeat options from the drop-down list of the “Repeat Rule” field.
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Once you have set the repeat rule, the “Repeat Until” and “Repeat For” fields
become active.  The “Repeat Until” field should be used when you know the
specific date when the event ends.  This date can be selected using the Quick
Repeat dialog box, which is accessed by clicking on the box to the left of the date
be used to repeat the event in increments such as days, weeks, month, etc.  The
increments are determined by the repeat rule.

o Choose either the “Repeat Until” option or the “Repeat For” option to
determine the ending date of the repeated event.  Only one of these
options can be selected.

The “Start Time” and “End Time” fields are used to indicate the starting and
ending times of the event, respectively.  (See, Displaying Start and End Times
following in this chapter.)

The “Duration” fields display the difference between the starting and ending times.
You can set the times using the arrow buttons beside each field, or you can use the
“Duration” fields by entering the data in “Days,” “Hours,” or “Minutes” fields.
The input will be carried over to any corresponding fields.

The “Category” field is used to indicate the category of the event.  The drop-down
category list will be populated with the default categories provided with Calendar
Creator, plus any user-defined categories you have created.

The “Priority” field is used to indicate the priority of this event in relation to other
events on your Event List.

The “Participants” field is used to add the names of people who are involved in the
event.  This field directly relates to your Address Book.  (Please refer to Chapter 4,
Address Book for information on populating your Address Book.)

o To add participants to your event, choose the SELECT button in the
Participants area.
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The Participant Selection dialog box will appear and resemble the figure shown
below.

Participant Selection Dialog Box with Sample Names

o Move names to the Selected Contacts column by selecting the name in
the Available Contacts column, then activating the right arrow button
located between the two lists.  The right double-arrow button can be used
to move an entire group to the Selected Contacts side.  Select the OK

button when you are finished.

Likewise, names can be removed by selecting the name, then activating the left
arrow button located between the two lists.  The left double-arrow button can be
used to move an entire group from the Selected Contacts side.  You can also use
the REMOVE button on the Add Event dialog box to remove selected names.

o Enter the requested information as it applies to your event.  When you are
finished, continue reading to add formatting and other controls to the event
or click on the OK button to add the event to your Event List and Calendar.

DISPLAYING START AND END TIMES

Before the start and end times for any single event or event category will appear on
your calendar, the start/end time checkboxes must be selected in the Miscellaneous
tab on the Layout Object Properties dialog box.  This enables the start/end options
for the entire calendar grid.  When an event is entered, the default value (12:00
am) for the start and/or end times must be changed or the start/end times will not
be displayed on your calendar.

o To display the start and end times of one specific event on your calendar,
select the start/end time checkboxes on the Style tab in the Event
Properties dialog box.

o To display the start and end times of one specific category on your
calendar, select the start/end time checkboxes on the Style tab in the
Categories Properties dialog box.
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REPEATING EVENTS USING THE ADVANCED REPEATS RULE

This section explains how to manage events that are repeated in a more complex
manner than is discussed above (i.e., repeat for extended years, have exceptions, or
should be moved for weekend occurrences).  These settings are controlled using
the ADVANCED REPEAT RULE button on the Add Event dialog box.

o Access the Event Properties dialog box using one of the methods
discussed earlier in this chapter in Accessing the Event List.  Then, click
on the ADVANCED REPEAT RULE button.

The Repeats dialog box will appear and resemble the figure shown below.

Repeats Dialog Box

The first step to setting the repeat is to define the repeat occurrence rule.  This is
done by selecting one of the three repeat options, or manually entering the dates in
the “Start Date” field (indicates the date of the first occurrence of the event) and
the “Repeat Until” field (indicates the last day the event will be repeated).

! The icons beside each of these fields can be activated to access the Quick
Date dialog box.  For further instructions on using this box, please refer to
Chapter 2, Getting Started.

If you choose to indicate the repeat dates using one of the three repeat options, the
lower half of the box changes according to the option selected.  Each option is
discussed below.
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• When you select the “Year, Month, Day” item, three columns will appear
listing year numbers, month names, and days in dates (1–31).  Checking
the “All Days,” “All Months,” or “All Years” items will selected all
times listed.

• When you select the “Year, Month, Week, Weekday” item, four columns
will appear listing year number, month names, week numbers (1–5), and
day names (Monday through Sunday).  Checking the “All Days,” “All
Months,” or “All Years” items will select all the times listed.

• When you select the third option, “Every,” three fields are displayed
prompting you to indicate increments of time (e.g., 4 months, 5 years, 2
days, etc.) and to select which days, by date (1–31), you want the event
to repeat.

The right portion of the Repeats box displays a month calendar layout.  This
calendar is provided for you to indicate any exceptions to the “Repeat Occurrence
Rule.”  Exception dates are selected by clicking on the date in the calendar.  As
you do this, the dates are listed in the drop-down menu of the “Exceptions” field.
If there are no exceptions to the rule, this field remains set to the default value of
“No Exceptions.”

You can change the month displayed using the arrows located on either side of the
month name.  The two single arrows change the calendar dates to the next (right
arrow) and previous (left arrow) month.  The two double arrows change the
calendar dates to the same month in the next (right arrows) or previous (left
arrows) year.

The “Weekend Occurrences” field is used to automatically move the event to
another day when its repeated date falls on a weekend.  Possible options are
Monday, Friday, the closest weekday, delete the event occurrence, or move all
occurrences to weekends only.

o Following the instructions above, set the event to repeat as needed.
Then, select the OK button to save the changes.

Adding Styles to Events
Once you have “defined” your event, you can apply formatting styles to the event
text to enhance its appearance on your calendar.  Text style can initially be
determined for an event by its category (if you have defined the category a style).
However, the category style can be overridden using the controls on the Style tab
of the Add Event dialog box.

! The default font style for the Event List is set to MS Sans Serif 10.  This
cannot be changed using this tab, which only controls the event text as it
appears on your calendar.

o Access the Add Event dialog box using one of the methods discussed in
Accessing the Event List in this chapter.  Then, select the Style tab.
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The Style tab will appear and resemble the figure shown below.

Add Events Dialog Box Showing the Style Tab

The Text style options are located in the right portion of the Style tab and include
Justification, All Caps, and a FONTS button.

• Justification is used to position the text to the left, right, or center of the
cell.

• All Caps, when checked, will change the font to appear in ALL CAPITAL

LETTERS.

• The FONTS button is used to access the Font dialog box, which contains
the available fonts and font styles.

The Event Effects portion of this tab allows you to indicate whether the text should
be placed on your calendar as a Box Event or a Banner Event.  The “Shading” and
“Color” fields are used to add shading and color to the event text.  The “Border
Style” and “Border Color” fields can be used to control the border that appears
around your event text on your calendar.  The “Show Shadow” box can be checked
to add a shadow effect around your event text.  A preview of your customized style
will appear in the “Sample” area as you make changes.

o To change the font, click on the FONTS button.



4 - 16               Calendar Creator User’s Guide

The Font dialog box will appear and resemble the figure shown below.

Sample Font Dialog Box

This dialog box operates as it does on other Windows-based applications.

• Font lists the fonts available with Calendar Creator.

• Font Style lists the styles available with each font.

• Size lists the sizes available with each font.

• Effects allows you to add strikeout marks or underlines to the selected
font, as well as select the color of your text.

• Sample shows a preview of the selected font with the applied settings.

• Script lists the available language scripts for the specified font.

o Select the desired settings, then save the changes by clicking on the OK

button.

The dialog box will close and the font and style will be applied to the event (on the
calendar—not the Event List).  All other events in that category, however, will
continue to appear with the Category style applied.
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Associating Pictures with Your Events
As was discussed earlier in this chapter, you can assign pictures to your events.
When you do so, the picture will appear in the Icon column on your Event List.

o Access the Add Event dialog box using one of the methods discussed in
Accessing the Event List.  Then, select the Picture tab.

The Picture tab will resemble the screen shown below.

Add Event Dialog Box Showing the Picture Tab

! No picture files will be listed when you first access this tab.  As you import
these files, they will be added to the “Picture in this Calendar” list.

Pictures are added to the  “Picture in this Calendar” list by using the BROWSE

feature (shown opened in the following figure) to scan your files.  Refer to your
Windows user’s guide if you are unsure how to search your files.
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Open Dialog Box Used to Browse Files

o Browse your files to find your pictures, then click on the OPEN button.

This will place the picture file in the Pictures in this Calendar list.

The “Time Period” field located at the top of this box can be used to place the
picture next to the item on your Event List for a specified time period only.

The image selected in your “Pictures in this calendar” list can be formatted using
the buttons located in the lower, left portion of the tab and the check boxes located
in the lower, right portion of the box.  The functions of each button and box are
described following.

• Rotate 90° will flip the image 90 degrees to the right.

• Save to Disk will prompt the file directory so the image can be saved as
a bitmap file.

• Flip Horizontally will flip the image to the left creating a mirror effect.

• Flip Vertically will flip the image upside down creating a mirror effect.

• Delete will remove the image from the “Pictures in this Calendar” list.

• Purge will purge the previewed image and any formatting adjustments
made to it.

• Brightness will increase or decrease the intensity difference between the
lighter and darker elements of the image.
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• Fit to Area is used to enlarge or shrinks the image to fit the selected area
as much as possible while keeping the image’s original proportions
(Proportional), to fill the entire area regardless of the proportions
(Complete), or leave the image as is (No change).  You can only select
one of these options at one time.

• Tile produces the picture as in a tile format.

• Center places the picture in the center of the selected area.

! You can select either Tile or Center, but not both at the same time.
Likewise, you cannot select Tile if you have selected a Fit to Area option.

• Transparent allows you to select a color (e.g., background color) to
make transparent (i.e.,␣ remove from the picture).  To the left of this
toggle box is a field labeled “Transparent Color.”  The color displayed in
this field indicates which color is transparent.  To change the color, either
click the mouse button in the color field to retrieve the Color dialog box
to select a color, or click on the dropper icon, then point to the color in
the previewed picture that you want to be transparent.

• Link to the File allows you to save the file path (not the actual file) in
your calendar file.

M Pictures require a large amount of memory.  Saving them in your file
may slow the speed of your system as well as occupy a large amount
of your hard drive space.

The last formatting tool located between the buttons and check boxes is used to
pan around the image.  Hold the mouse button and move the cursor to view
different parts of the image.

o Apply any formatting properties to the picture, then select the OK button on
the Add Event dialog box to insert the image on your Event List.

Applying Functions to Events

The Functions tab is used to apply text functions.  Text functions are defined as the
variable text that is supplied by the program to be added to event descriptions and
various calendar elements.  To further explain, refer to this example.  If you apply
the “&date” function to an event or text cell, the date displayed will be
proportional to the actual date.  If you switch the calendar view using the previous
or next period arrows, the date displayed will be automatically adjusted.

To apply a function to an Event:

o Select the Functions tab from the Add Event dialog box.
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The Functions tab will appear and resemble the figure shown below.

Add Event Dialog Box Showing the Function Tab

Select the desired topic and function from the each list.  As you position the cursor
on each of the functions available, a complete description of its function will be
provided.  Use these descriptions as a guide to help you select the right function
for your needs.

o Once you have selected the topic and functions, apply them by activating
the PASTE FUNCTION button.  Then, save your changes by activating the OK

button.

Attaching Notes to Events
The Notes tab is used to attach additional information to an event.  This additional
information is indicated on your Event List by a symbol resembling a note-like
symbol that appears in the “Notes” column.  It is indicated on your Calendar by
this same icon.  Moving the cursor over the icon in either case will display the
noted information in a pop-up box.

o Access the Add Event dialog box using one of the methods discussed in
Creating and Maintaining Event Categories.  Then, select the Notes tab.
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The Notes tab will appear and resemble the figure shown below.

Add Event Dialog Box Showing the Notes Tab

This box contains a blank area where your notational information can be typed.
You can use the formatting controls (font style and size, bold, italicized,
underlined, color and justification) to add style to your text if desired.

o Type your note in the indicated area, applying formatting controls if
desired.  When you are finished, select the OK button to SAVE the
information.

Again, your notes are indicated by a note-like symbol that appears in the event cell
and in the “Notes” column on your Event List.

Setting the Alarm to Accompany Events
The Alarm tab is used to play a sound, launch an application, or compose a
message that will indicate the occurrence of a specific event.  Calendar Creator
operates in conjunction with Calendar Creator Scheduler when using alarms.
Therefore, please refer to the “Using Calendar Creator Scheduler” section of this
chapter for more information on how this process works.

o Access the Add Event dialog box using one of the methods discussed in
Creating and Maintaining Event Categories.  Then, select the Alarm tab.
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The Alarm tab will appear and resemble the following screen.

Add Event Dialog Box Showing the Alarm Tab

When you first access this screen, the Alarm settings will be disabled.  You must
select the “Alarm” option to activate them.

o Select the “Enable Alarm” option to enable the alarm settings.

Once the settings are enabled, you can indicate using the “Hrs” and “Mins” fields
when in relation to the event date/time you want the alarm to occur.  These fields
work in conjunction with the “Before Event” or “After Event” fields to set the
actual alarm time.

o Indicate the time when the alarm should occur.

Three different types of alarms can be set:  Sound, which will produce a noise at
the time of the event; Launch, which will cause a specified program application to
be launched at the time of the event; and Message, which will produce a user-
defined message across your screen at the time of the event.  You can select apply
one, two, or all three of these types of alarms.

To set the Sound alarm:

o Select the alarm by placing an “X” in the “Alarm Sound” field.  Then, use
the standard Windows Browse feature to select the sound file that will be
used.  (If you are unsure of how to use the Browse feature, please refer to
your Windows user’s guide for instructions.)  Once you have linked the
sound file, you can test it by activating the TEST button.
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To set the Launch alarm:

o Select the alarm by placing an “X” in the “Alarm Launch” field.  Then, use
the standard Windows Browse feature to select the program to be
launched when the event occurs.  (If you are unsure of how to use the
Browse feature, please refer to your Windows Users Guide for
instructions.)  Once you have linked the program file, you can test it by
activating the TEST button.

To set the Message alarm:

o Select the alarm by placing an “X” in the “Alarm Message” field.  Then,
simply enter the text that you would like to appear on your screen when
the event occurs.

Sorting Your Event List
Once you have added an assortment of events to your Event List, you may find
that is cumbersome to scroll through your list.  Therefore, you can sort your Event
List so that only specific information is displayed.

There are two methods of sorting:  using the Category Type indicator field or using
the Sort item in the Events main menu

The Category Type Indicator field is used to list a specific category of events, such
as Birthdays, Meetings, To Do, etc.  Select a category using the drop-down menu
for the Category Type Indicator field (as shown below).

Example of a Drop-Down Menu for the Category Type Indicator Field

The calendar’s category options will be listed.  You can select a single category
type to display events only associated with that type, or you can select “All” to
view all events associated with all categories.
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The other means of sorting your events is by using the Sort item in the Events
main menu.  This option enables you to sort by start date, by description, by
priority, by category, or by start time.  When you select one of these options (e.g.,
start date), an up or down arrow will appear at the top of the column that you are
sorting (e.g., an arrow will appear in the Date column header).  Clicking on this
arrow will reverse the order of listing (e.g., from chronological order to reverse
chronological order).

Querying Your Event List
The Query feature makes if easy for you to locate a specific event in your Event
List.  For example, if your Birthday’s category contains 25 events, and you want to
search specifically for Aunt Ruthie’s birthday, you can enter “Aunt Ruthie” in the
“Text in Description” field.  Only her birthday will appear in your Event List.

o To access the Event Query dialog box, either select the Query item from
the Category Type Indicator drop-down menu, or select the Query item
from the Event main menu located at the top of the screen.

The Event Query dialog box, will appear.

Event Query Dialog Box

This box has four means of querying your events:  by a date range, by text in the
description, by priority, or by category type.  Choose one of these methods by
clicking the mouse button to place a check mark beside the method.  Then, enter
the information that will define your search criteria.
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The Event Report and Event Report 2-Column Views
The Event Report and Event Report 2-Column views allow you to view and print a
report of all, or just selected events in your event list.  You can show any
information associated with the event; such as titles, start/end times, dates, notes,
etc.  Using this view, you can customize the information displayed in your Event
Report view or Event Report 2-Column view.  This will also allow you to select
specific information for printout on the Event Report.

To use the Event Report view:

o Select “Event Report” view in the View Type indicator field.  When
displaying the “Event Report 2-Column” view, only one column will be
displayed onscreen.  However, this will not affect the printout.

Event Report View

To format your Event Report:

o Right-click on the event grid.  Select Properties from the drop-down menu,
and use the Style tab located on the Layout Object Properties dialog box.
Using the Miscellaneous tab, you can choose to display start/end times,
notes, or small calendars with your Event Report printout.

For instructions on printing reports from your Event List, please refer to Chapter
6, Printing Event Reports.
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Using the Scheduler to Activate Your Alarms

Calendar Creator operates in conjunction with Calendar Creator Scheduler when
activating alarms.  Therefore, it is important that you understand the basic concepts
about the application.  Calendar Creator Scheduler is a stand-alone application
that is automatically loaded on your computer when you install Calendar Creator.
It is placed in your start-up folder and appears on your desktop as a clock-like icon
( ) that appears in the lower-right corner of your menu bar.

When you save events files that contain alarms, Calendar Creator prompts you to
also save the file on Calendar Creator Scheduler.  This automatic process is
activated when you accept at the prompt.  Event alarms will not become active
unless they are saved to Calendar Creator Scheduler.

These alarm settings can be viewed and modified, if needed, using the Calendar
Creator Scheduler screen.  Additionally, new alarm that isn’t associated with your
event list files can be set using this screen.

o Access the scheduler screen by double-clicking on the Calendar Creator
Scheduler icon in your menu bar.

The Calendar Creator Scheduler screen will open and resemble the figure below.

Calendar Creator Scheduler Screen

The alarms that have been set using your event files will appear in this list.  Each
alarm can be modified from this list, if needed, by selecting the Modify item from
the Alarm main menu.  You can also delete or pause alarms by selecting the
appropriate item from this Alarm main menu while the alarm in issue is selected.

! When an alarm is paused. The PAUSE button toggles to RESUME ALARM.

To set a new alarm (not associated with Calendar Creator):

o Select the Add Alarm item from the Alarms main menu.
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This will display a version of the Events dialog that contains three tabs:  Event,
Alarms, and Repeat.  These three tabs operate similarly to the tabs described in the
Event Dialog section of this chapter.  Therefore, please refer to the corresponding
sections of this chapter for instructions on using these tabs.

! The exception to this is the Event tab, which differs in that the Scheduler’s
Event tab does not contain a Contact group.

Additional controls that can be applied to Calendar Creator Scheduler using the
File and View main menus, are discussed below.

The File main menu contains four submenu items used to perform the following
functions.

• Reload All polls all the files in Scheduler’s list (use View/File list to see
this list or to add or remove items from it).  It is updated automatically.

• Revert reloads the last saved version of the local file list (see
explanation below).

• Save Local saves the Local file.  Revert is disabled after saving until a
change in the Local file is made.  (See the paragraph that follows for an
explanation of “local files.”)

• Close exits the Scheduler window, but does not exit the program.

The View main menu contains four submenu items that are used to perform the
following function.

• Add displays the standard Windows Open File dialog box that can be
used to select a calendar file to add to Scheduler.

• Remove deletes the Calendar file from the list and removes its alarmed
events from Scheduler’s alarms list.

• OK dismisses the dialog and accepts the changes.

• Cancel dismisses the dialog and does not keep any changes made.

! Help displays the Scheduler’s Help and About boxes.

When you add alarms settings to the Scheduler program, these are considered to be
“local” alarms.  Local alarms differ from the alarms that are set up using Calendar
Creator in that local alarms don’t have to be linked.  The alarms set up using your
Event List must be linked.

Properly set up alarms will be automatically activated without requiring you to
open the Calendar Creator Scheduler or Calendar Creator program.
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Using the Address Book

Calendar Creator provides you with everything you need to help keep your busy
life on schedule.  One way to stay on schedule is to save time by having needed
information in one place.  Calendar Creator’s Address Book feature helps you
keep your schedule and your personal and business contacts in one easy-to-use,
electronic format.

The Address Book works exactly like a real Address Book by storing your business
and personal addresses, phone numbers, fax numbers, pager numbers, and cell
phone numbers in one location.  But, it goes beyond the abilities of the typical
address book in that it can also perform the following functions.  The Calendar
Creator Address Book can:

• Categorize your contacts into Groups; such as your Exercise Group, your
daughters Girl Scout Group, your Best Friends, your Business Clients,
etc.

• Store e-mail addresses and Web sites.

• Send e-mail to those in your address list directly from the Address List
screen.

• Link names from your address list to your scheduled events.

• Telephone people on your list directly from the Address List screen.

As an extra feature, you can choose to sort your Address List in a variety of ways
so that you only see the information that is useful to you at that time.

This chapter explains how to access the Address List, add, modify and remove
contacts, categorize and sort contacts, send e-mail, and make phone calls from the
Address List screen.

Accessing the Address Book

The Address Book is one of the four main views of Calendar Creator (the other
three being the Event List, the Clip Art screen, and the seven Calendar views).  It
is accessed using any of the following methods.

o Access the Address Book screen by activating the Address Book button in
your toolbar (see Chapter 2, Screen Definitions for Calendar Creator ), by
selecting the Address View option from the Address main menu located at
the top of the screen, or by selecting the Address List item from the Active
View Indicator field.
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! If a contact has been previously added to your list, you can also retrieve
their data by double-clicking the mouse button while the cursor is
positioned on the item in the Address List.

The Address List will display in one of the three Address List views:  Small Icons,
Large Icons, or Details.  The following figures show examples of the same Address
List displayed in each of these views.

Address List in “Small Icon” View

Address List in “Large Icon” View

Address List in “Detail” View

To select your view of the Address List:

o Select the View item from the Address main menu located at the top of the
screen.  Then, either select the Small Icons, Large Icons, or Details item.

You will notice in the examples above, how the contacts in each view have one of
two icons beside them (i.e., either profile icon or two profiles facing each other).
These distinctive icons indicate whether the contact is either a single contact
(profile icon) or a group of contacts (two profiles facing each other).

Also, in each of the examples above, you will notice an alphabetized tab located to
the left side of the Address List.  This tab provides one of the methods of sorting
your address list.  It is discussed in detail in Sorting Your Address List, along with
the other methods of sorting.  (Displaying this tab is optional and can be disabled
by following the instructions in the Data Display Tab section of this chapter.)

Adding Contacts to Your Address List
Adding contacts to your Address List is quick and easy.  They are recorded using
the Address Book Details dialog box.  This dialog box has five tabs:  Contact,
Home, Business, Events, and Notes.  The Contact tab is used to add the person’s
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name and contact information.  The Home tab is used to add the person’s home
address information.  The Business tab is used to record a business name and
address.  The Events tab is used to display the events in which the contact is
scheduled to participate.  And the Notes tab is used to record notational
information about the contact.  Each of these tabs is discussed in the following
sections.

CONTACT TAB

The Contact tab is used to record and maintain the person’s name information.  It
also stores their e-mail and telephone/pager number(s) and can be used to
automatically send e-mail or dial the indicated number.

To access the Contact tab:

o Select the New Contact item from the Address main menu located at the
top of the screen or simply double-click the mouse button while it is
positioned in an empty area of your Address List.

The Address Book Details dialog box will appear showing the Contact tab.  The
figure below illustrates this screen.

Address Book Details Dialog Box Showing the Contact Tab

The “First,” “Last,” “Middle,” and “Prefix” fields are used to indicate the name of
the contact (e.g.,␣ Mr.␣ John B. Jon).  The “Nickname” field is used to enter the
person’s nickname, if it applies (e.g.,␣ JJ).  You can enter as little or as much
information as needed in these fields.
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Below these name fields are the E-Mail and Phone/Pager lists.  They are provided
to maintain the person’s e-mail address and phone/pager numbers, respectively.
This information can be relayed to the Microsoft® Exchange® e-mail software or
your modem using the SEND and DIAL buttons.

o To add e-mail information, select the ADD button beside the “E-Mail List”
or simply double-click the mouse button while it is positioned in an empty
area in the list.

Add New E-Mail Address Dialog Box

The “E-Mail” field is used to enter a description of the address, such as the
person’s name or e-mail location.  The “E-Mail Address” field is used to enter their
e-mail address.

o Enter the e-mail information and address, then select the OK button to save
the data.

The data will display in the “E-Mail Description” and “Address” fields on the
Contact tab.  Repeat this step as needed to add additional addresses.

o To add telephone/pager number information, select the ADD button
located beside the Phone/Pager list or simply double-click the mouse
button while it is positioned in an empty area in the list.
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Add New Phone Number Dialog Box

The “Phone” field is used to indicate the person’s three-digit area code and seven-
digit phone number.  The “Description” field is provided to store information
relevant to the listed number.  You can enter as much or as little information in
these fields as applies.

o Enter the desired telephone/pager information in the appropriate fields,
then select the OK button to save the data.

The data will display in the “Description” and “Phone Number” fields in the
Phone/Pager list.  Repeat this process as needed to add additional numbers.

o To modify e-mail or phone/pager number information, select the item
in the appropriate list, then activate the MODIFY button located beside the
list or double-click the mouse button.  The person’s information will be
displayed on the Contact tab.  Make the necessary modifications, then
save the data by activating the OK button.

o To remove e-mail or phone/pager number information, select the item
in the appropriate list.  Then, activate the REMOVE button next to the list.
The information will be deleted.

o To select an e-mail address or phone/pager number as the default,
select the item in the appropriate list.  Then, activate the DEFAULT button
next to the list.  This will mark the address or number as the default.

o To send an e-mail message, select the address in the E-Mail List, then
activate the SEND button.  Microsoft® Exchange® will be activated, and the
address will be imported to that appropriate address field.

o To automatically dial a number, select the number from the Phone/
Pager List, then activate the DIAL button.
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You can remove contacts from your Address List by highlighting the name in your
Address List, then selecting the Delete Selected item from the Address main menu
located at the top of the screen.

HOME TAB

The Home tab of the Address Information dialog box is used to maintain home
address information.

To access the Home tab:

o Select the New Contact item from the Address main menu located at the
top of the screen or simply double-click the mouse button while it is
positioned in an empty area of your Address List.  Then, select the Home
tab.  If the contact is already in your address book, double-click on the
item to access the Address Book Details dialog box.

The Home tab will appear and resemble the figure shown below.

Address Book Details Dialog Box Showing the Home Tab

o Enter the person’s home address information (up to two street addresses,
city, state, zip, and country).  If they have a Web site, you can record their
site address in the “Web” field.  Selecting the OPEN button located next to
the “Web” field can access this site.  Save the data by activating the OK

button.

! It should be noted that the certain fields on this tab can be pre-populated
with default data by entering this data on the Default Data tab of the
Address Book Options dialog box.
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BUSINESS TAB

The Business tab of the Address Information dialog box is used to maintain
business address information.

To access the Business tab:

o Select the New Contact item from the Address main menu located at the
top of the screen or simply double-click the mouse button while it is
positioned in an empty area of your Address List.  Then, select the
Business tab.  If the contact is already in your address book, double-click
on the item to access the Address Book Details dialog box.

The Business tab will resemble the figure shown below.

Address Book Details Dialog Box Showing the Business Tab

o Enter the name of the company with which the contact is associated in the
“Company” field.  Then, enter the Department name and their title or
position in the “Department” and “Position” fields.

o Next, enter the person’s business address information (up to two street
addresses, city, state, zip, and country).  If they have a Web site, you can
record their site address in the “Web” field.  Selecting the OPEN button
located next to the “Web” field can access this site.  Save the data by
activating the OK button.

! It should be noted that the certain fields on this tab can be pre-populated
with default data by entering this data on the Default Data tab of the
Address Book Options dialog box.
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EVENTS TAB

The Events tab lists all events in which the person is scheduled to participate.  It
can also be used to disassociate the contact from the event.

To access the Events tab:

o Select the New Contact item from the Address main menu located at the
top of the screen or simply double-click the mouse button while it is
positioned in an empty area of your Address List.  Then, select the Event
tab.  If the contact is already in your address book, double-click on the
item to access the Address Book Details dialog box.

The Events tab will resemble the figure shown below.

Address Book Details Dialog Box Showing the Events Tab

When this screen opens, any event in which the person is participating will be
listed.  The check box located to the left of the event information can be disabled
(by removing the check mark) to disassociate the person and the event.

To remove event information:

o Activate the REMOVE button while the event is selected in the list.

The event will no longer appear in the list.
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NOTES TAB

The Notes tab can be used to store notational information with the person’s file.

To access the Notes tab:

o Select the New Contact item from the Address main menu located at the
top of the screen or simply double-click the mouse button while it is
positioned in an empty area of your Address List.  Then, select the Notes
tab.  If the contact is already in your address book, double-click on the
item to access the Address Book Details dialog box.

The Notes tab will resemble the figure shown below.

Address Book Details Dialog Box Showing the Notes Tab

This tab contains a blank area where the notational information can be entered.
You can use the formatting controls (font style and size, bold, italicized,
underlined, color and justification) to add style to your text, if desired.

o Type your note in the indicated area, applying formatting controls if
desired.  When you are finished, select the OK button to SAVE the
information.
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Creating Groups
As previously discussed, Calendar Creator now gives you the capability to store
your contacts who share similar associations (e.g., company softball team) as
Groups.  Groups should be created after each member has been recorded in your
Address Book as a contact.  Once this is done, they can be grouped using the
Address Group dialog box.

o Access Address Group dialog box by selecting the New Group item from
the Address main menu located at the top of the screen.  If the group has
been previously established, you can access it by positioning the cursor
on the item in the Address List, then double-click on the item.

The Address Group dialog box will appear and resemble the figure shown below.

Address Group Dialog Box with Sample Data

! It should be noted that your dialog box might display in the Large Icon
view depending on the Address view you have chosen.

o Enter the name of the group in the “Group Name” field.  This name will
appear in the Address List as the contact name.  Relevant notes about the
group can be entered in the “Notes” field, if desired.

o Simply select the ADD button to link contacts to the group.
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The Participant Selection dialog box will appear and resemble the figure shown
below.

Participant Selection Dialog Box with Sample Data

This box is divided into two lists.  The Available Contacts side will list everyone in
your current address book.  The Selected Contacts side will list those contacts that
are group members.

! The arrow symbols in the list headers can be used to sort the names in
ascending or descending alphabetical order by simply clicking in the
header field.

o To associate these contacts with the group, select the name from the
Available Contacts list, then click on the right arrow symbol between the
two lists.  The name will appear in the Selected Contacts list.  Likewise,
you can remove contacts from the group by selecting the item, then
clicking on the left arrow symbol.

o Once you have assigned your group members, save the data by activating
the OK button.

The selected contacts will appear in your Group Members List.  Once you have
defined your group, you can send e-mail to your group members using the E-MAIL

button on the Address Group screen.  This will launch the MS Exchange™

application that can be used to send the mail to each group member at one time.

You can remove individual names from the Group list by selecting the REMOVE

button on the Address Group box while the cursor is highlighting the name.  You
can also modify a group member’s information directly from this screen by
selecting the member, then activating the MODIFY button.  The Address Book
Details dialog box will appear.
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Groups can be removed at any time from your Address List by highlighting the
group name, then choosing the Delete Selected Item from the Address main menu
located at the top of the screen.

Sending E-Mail
As mentioned in previous sections, Calendar Creator gives you the ability to send
e-mail to your contacts.  This can be done from the Contacts tab of the Address
Book Detail dialog box, from the Address Group dialog box, or using the Send E-
Mail option on your Address main menu.  Using any of these methods will launch
the Microsoft Exchange™ software application, which is used to compose and send
your mail.

Setting Your Address Book Options
Your Address Book can be customized to meet your personal needs using the
Address Book Options tabs.  These tabs (General and Default Data) allow you to
indicate what information you want to display in you address list, indicate the
name display sequence, and enter default data that will be provided when creating
new contacts.  These tabs are discussed below.

GENERAL TAB

The General tab, shown below, is used to control the presence of the alphabetized
tab and the data tips, as well as control the name sorting method and the columns
that appear in your Address List.

To access the General tab:

o Select the Options item from the Address main menu located at the top of
the screen.  Then, select the General tab.
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The Address Book Options dialog box will appear with the General tab selected, as
shown in the following figure.

Address Book Options Dialog Box Showing the General Tab

o To display the Alphabetic tab on the Address List, activate the “Show
Alphabet Tab” setting by clicking the mouse button to place a check mark
in the box.  Click again to remove the check and disable the setting.

o To display the data tips that appear as you hold the cursor over a button
in you toolbar, activate the “Show Data Tips” setting by clicking the mouse
button to place a check mark in the box.  Click again to remove the check
and disable the setting.

o To display grid lines on the Address List, click the mouse button to place
a check mark in the box.  Click again to remove the check and disable the
setting.

The Name Field Sorting settings are used to indicate the method you want to use
when sorting contact names.  This can be either “Last/First,” “First/Last,” or
“First/Middle/Last.”

o Select one of the three methods to be used when sorting your contacts by
name.  This setting can also be changed using the View item under the
Address main menu.
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The remaining portion of this tab is used to control the information that displays on
your Address List.  This tab operates similarly to the Add Group tab.  It is divided
into two lists.  The Available side lists the information available for display.  The
Displayed side lists the information that will appear on the Address List screen.

o To place Available data on your Address List screen, select the descriptive
name from the Available list, then click on the right arrow symbol between
the two lists.  The item will appear in the Displayed list.  Likewise, you can
remove data from the Address List screen by selecting the item, then
clicking on the left arrow symbol.

! The RESET button will clear the Selected list to reset your selections.  The
UP and DOWN buttons can be used to scroll through your list.

o Once you have made all necessary adjustments to these options, save the
data by activating the OK button.

DEFAULT DATA TAB

The Default Data tab is used to enter the data that will pre-populated when you
create new contact records.

To access the Default Data tab:

o Select the Options item from the Address main menu located at the top of
the screen.  The select the Default Data tab.
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The Address Book Options dialog box will appear with the Default Data tab
selected, as shown in the following figure.

Address Book Options Box Showing the Default Data Tab

o Simply enter the appropriate information in each field that you would like
to be pre-populated when creating new contacts.  You can enter as much
or as little data as desired.  When you are finished, select the OK button to
save the information.

! The RESET button will clear the current settings to allow you to set new
default settings.

Sorting Your Address Book
Calendar Creator offers several methods of sorting your Address Book.  These are
as follows:

• Use the Alphabet tab located to the left of your list (if you have this
option enabled).

• Use the “Search Name” field located at the right corner of your list.

• Use the Active View indicator screen drop-down list.
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o To use the Alphabet tab, simply select the beginning letter by which you
want to sort (e.g., selecting S will display names such as Smith, Simon,
Shelton, etc.).  The arrow tabs at either end of the alphabetic tab are used
to move up or down the tab.  The ALL tab item will prompt the system to
list all addresses in your list.

o To use the “Search Name” field, simply position the cursor in the field
(located at the right corner of your Address List), and then enter one or
more letters to refine your search.

o To use the View indicator list, select either the “Addresses and Group”
item, “Addresses Only” item, “Groups Only” item, or one of the group
names listed at the bottom of the drop-down list.

Searching Your Address Book
You can search your Address Book for specific information using one of the Find
Address feature or the Query feature.  The Find Address feature allows you to
search using basic information.  The Query feature allows you to refine your
search by adding Search Filers.  Each of these is discussed below.

o To use the Find Address feature, select the Find Address item from the
Address main menu.

The Find dialog box will appear and resemble the figure shown below.

Find Dialog Box

This field contains two fields and two toggle boxes. The “Find What” field is used
to indicate the information you want to search for.  The “In Field” field is used to
specify the field by which you want to search.  If you are unsure of the exact
information that appears in the fields, you can check the “Field Contains” box to
make the search less specific (i.e., you can search for partial information).  If you
want to match the case of the “Find What” item, check the MATCH CASE box.
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o Enter your search criteria, then initiate the search by activating the OK

button.

Your Address Book will be adjusted to display the appropriate information, if
found.

o To use the Query feature, select the Query item in the Address main
menu.

The Search for Records dialog box will appear and resemble the figure shown
below.

Search for Records Dialog Box

The top portion of this box is similar to the Find dialog box.  You enter the
information you want to find, then specify the field where this information may be
listed.  The lower portion is used to refine your search by specifying several search
criteria (or filters).  Adding filters allows you to specify more than one “In Field”
and “Search For” entries.  Each time you enter the search criteria in these fields,
you activate the ADD FILTER button.  The search criteria becomes the filter
information and it is placed in the filter list.  This process can be repeated as many
times as is necessary to apply as many filters as needed.

o Enter your search criteria and any filters, then initiate the search by
activating the OK button.

Your Address Book will be adjusted to display the appropriate information, if
found.

The REMOVE button will remove a search filter from the list.  The CLEAR button will
clear the selected item(s), and the REMOVE ALL button will remove all search filters
listed.
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Importing Files into Your Address Book
Calendar Creator allows you to import other address book files (*.ab5) or comma
separated value (*.csv) files into your Address Book.

To import files into your Address Book:

o Select Import from the File menu.  Then, select Address from the drop-
down menu and select the file type to be imported (*.ab5 or *.csv).

! If an address book file is currently open when using the Import feature, the
file being imported will merge with the file currently open, creating a
single address book file when saved.

When importing (*.csv) files, the Import Fields dialog box will appear.  This
dialog is used to assign properties to each field being imported into the Address
Book.

o Select the first checkbox to convert any special DOS-based characters
that are contained in the file being imported.

o Select the second checkbox to have the first line of the file imported as a
header.

o Assign each field in the imported file to an address book field by clicking
on the column header labeled, “Unassigned,” and select the Address Book
field from the drop-down list.  Then, click on the OK button.
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Printing Your Calendar

Calendar Creator gives you more printing capabilities than ever!  You can now
print a professional looking calendar right at home by selecting one of the many
calendar layouts offered by this new version of Calendar Creator.  You can choose
from among the following layout possibilities to create the calendar that’s perfect
for your needs.

• Print a single-page calendar.

• Print two or more calendars on one page.

• Print multiple calendars on double-sided pages.

• Print one calendar printed on multiple pages (for a poster-like calendar).

• Print multiple calendars in InstaBook™ style.

You can also set up your printing options to include:  pictures above, beside,
behind, or inside your calendar.  The possibilities are limited only by your
imagination.

Because there are so many printing options, Calendar Creator provides a
mechanism for verifying all user-defined print settings to ensure that the setting
combinations coincide.  For example, if you set your calendar size too large for the
current page size setting, Calendar Creator will recognize the inconsistency and
prompt you to change one of the settings.  Likewise, if you specify to print on
legal-size paper, but the printer tray contains letter-size paper, the software will
alert you of the error.  This will help you to save time and reduce the costly waste
of paper.

Preparing to Print

Most simple print jobs can be handled using the default print settings.  However,
as you become familiar with the vast printing options available with Calendar
Creator, you will want to utilize the options to produce highly sophisticated
calendars.

The Print Layout dialog box is the main controller you will use during printing.

o Select the Print Layout item from the File main menu located at the top of
the screen.
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The Print Layout dialog box will appear and resemble the figure shown below.

Print Layout Dialog Box with Layout Tab Displayed

Print Layout
The Print Layout dialog box is comprised of four tabs:  Layout, Page, Calendar,
and Margins.  The Layout tab is used to select the basic layout.  The Page tab is
used to select the page stock and size, as well as adjust the margins.  The Calendar
tab is used to select the number of calendars and pages that will be printed.  And
the Margins tab is used to control the calendar margins.  Each of these tabs is
discussed in the sections below.

LAYOUT TAB

The Layout tab (shown in the figure above) is used to select the basic layout of
your calendar.  This includes the layout (regular or InstaBook), the time span to be
included in the printout, the orientation of the calendar(s) on the page, and binding
margin setting.

The “Print Mode” field allows you to select between a Regular print mode and the
InstaBook print mode.  Based on your selection in this field, the “Current Layout”
field below it will list your layout options.  As you select one of these options, a
preview of the page will appear in the Page Preview area.

When you are trying to determine whether to use Regular or InstaBook printing,
think about how you want to use your calendar.  InstaBook calendars are printed
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double-sided with fold and cut lines that, when followed, can be assembled into a
booklet bound by staples, comb binding, etc.  If you don’t want your calendar in
this format, select the Regular printing option to produce a single-sided calendar
that contains the specified number of calendars per page.  You can also use this
setting to print poster-size calendars.

In addition to these print layouts, you can select the Custom layout option (under
the “Current Layout” drop-down list) to customize your layout setting.

The Time Slice options are used to indicate the time range to be included in the
printed calendar.  The “Start Date” field automatically adjusts to start date of the
current calendar being used.  This can be adjusted as needed.  The “Periods” field
is used to indicate the number of periods to print.  A period is defined as the time
span of the current calendar in view.  For example, if you are viewing a multi-week
calendar (e.g., 6 weeks), increasing the period to “2” will result in a 12-week
calendar printout.  Likewise, if you are using a 1-month calendar, increasing the
period to “4“ will result in a 4-month calendar printout.  The “End Date” field is
used to indicate the last date to include on the calendar.  This field will
automatically adjust according to the indicated period, but can be changed as
needed.

The Page Orientation options allow you to arrange the calendar(s) in portrait or
landscape position on the page(s).

The Binding Margin options all you to adjust the page margins to allow room for
binding the calendar at the top or the side.

o Modify the Calendar Layout settings as desired.  When you are finished,
apply these settings by activating the OK button. You can save (and
retrieve at any time) your new print settings, if desired.  This is done by
activating the SAVE button rather than the OK button, then entering the
name in the Add New Print Layout dialog box that appears.  This name will
appear in the drop-down menu for the “Current Layout” field where it will
remain until such time that it is deleted by activating the DELETE button
beside the “Current Layout” field.

! It should be noted that the most recent print settings will remain as the
default the next time the Print Layout dialog box is accessed.  However,
unless you save the settings, they will be replaced by the next layout
settings.

PAGE TAB

The Page tab is used to select the paper stock and size, as well as to adjust the
margins.

o Select the Page tab from the Print Layout dialog box.
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The Page tab will appear and resemble the figure shown below.

Print Layout Dialog Box with Page Tab Displayed

The “Choose Paper Stock” field is used to indicate the size of your paper.  It
operates in conjunction with the “Print Mode” and “Current Layout” settings on
the Layout tab.  That is, a default paper stock will be provided.  However, this can
be changed as needed.  Doing so, will in turn change the “Current Layout” field on
the Layout tab to “Custom.”

To choose a predefined paper stock:

o Select the paper stock from the “Choose Paper Stock” drop-down list, then
click on the OK button.

! If you have chosen an InstaBook layout from the Layout tab, the “Choose
Paper Stock” field will be prepopulated with the paper stock that
corresponds to the current layout.

If the paper stock you’re using isn’t provided as one of the predefined paper
stocks, you can add the new paper stock to this list by activating the ADD button.
This will produce the Add New Paper Stock dialog box where the new stock name
and dimensions can be entered.

To add new paper stock to the “Choose Paper Stock” drop-down list:

o Select the ADD button on the Page tab of the Print Layout box.
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This will produce the Add New Paper Stock dialog box.

Add New Paper Stock Dialog Box

o Enter the name or description of the paper in the “Paper Stock Name”
field.  Enter the width and height of the paper, then save the new paper
information by clicking on the OK button.

The paper stock will appear in the drop-down list until it is deleted. Alternatively,
you can delete paper stock from this list by selecting the item, then clicking on the
DELETE button.

If you don’t want to add the new paper stock to the list, you can choose the “Change
Paper Size Manually” option to adjust the width and/or height of the paper.

To set the paper size manually:

o Select the Change Paper Size Manually option, then enter the width and
the height of the paper in the appropriate fields.

! When you manually set the paper size, the “Choose Paper Stock” field
will be disabled and populated as “Custom.”  (See Printing on Custom
Paper Sizes later in this chapter.)

CALENDAR TAB

The Calendar tab is used to select between calendar/page settings.  You can
determine how many calendars (on a multi-calendar printing task) should be
printed on each page, how many pages a poster-size calendar should comprise, or
the calendar size by manually setting the calendar width and height.  Only one of
these options can be selected at a time.

o Select the Calendar tab from the Print Layout dialog box.
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The Calendar tab will appear and resemble the figure shown below.

Print Layout Dialog Box with Calendar Tab Displayed

Use the “Calendars per Page” option when you are printing multiple calendars on
one page.  You can indicate the number of calendars to print in columns (down)
and rows (rows).  The size of each calendar will adjust according to the selected
margins and paper stock.

Use the “Pages per Calendar” option when you are printing a calendar on multiple
pages (a poster-size calendar).

Use the “Set Size Manually” option to customize the width and height of your
calendar.

o Modify the Calendar settings as desired.  When you are finished, apply
these settings by clicking on the OK button.

MARGINS

The Margins tab is used to set the margins surrounding the calendar(s) and to
specify the point on the page where the first calendar will begin.  This is useful
when you are printing several calendars on one page; it will determine the amount
of space between each calendar.

o Select the Margins tab from the Print Layout dialog box.
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The Margins tab will appear and resemble the figure shown below.

Print Layout Dialog Box with Margins Tab Displayed

The Calendar Margins options are used to set the four margins bordering each
calendar.  They determine the amount of space between calendars when printing
multiple calendars on one page.

The Calendar Origin options are used to specify the point on the page where the
first calendar will begin printing.  This point is based on the edge of the paper—
not the calendar margin.

o Modify the Margin settings as desired.  When you are finished, apply these
settings by clicking on the OK button.

Once you have checked and modified the print layout settings, you can continue by
either previewing the calendar using the Print Preview screen (discussed in the
Print Preview section of this chapter), or by printing your calendar using the Print
screen (or command).
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Print Options
Once your print layout options have been established, the Print item in the File
main menu can be used to initiate printing.  You can also control various settings
for the printer from this menu item.

o Select the Print item from the File main menu located at the top of the
screen, or activate the Print icon located in the main tool bar.

The Print dialog box will appear and resemble the figure shown below.

Print Dialog Box

This box is comprised of five tabs:  Printing, Advanced, Trays, Regular, and
InstaBook.  Each of these tabs is discussed below.

PRINTING TAB

The Printing tab (shown in the figure above) is used to select the printer you are
using as well as control its various properties.  It is also used to control double-
sided printing, print to a file, show the “Caution: Printing” dialog, and set the
number of copies to be printed.

o Select the name of your printer from the “Name” drop-down list.  To add a
printer that is not in this list, please refer to your printer’s user
documentation for details on setting its property options.

The “Double sided” option, when checked, will indicate to the software that the
documents will be printed as a double-sided document.
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The “Print to File” option, when checked, will indicate to the software that the
information is to be stored to a specified file.

The “Show ‘Caution: Print’ dialog” option, when checked, will prompt the system
to alert you for verification each time the printing queue is activated.

The “Number of Copies” field is used to set the default number of copies that will
print with each print command.

o Modify the Printing settings as desired.  When you are finished, apply
these settings by activating the OK button.

ADVANCED TAB

The Advanced tab is used to perform various advanced printing features, such as
adding a cover page, inserting blank forms during printing, printing a picture, etc.

o Select the Advanced tab from the Print dialog box item.

The Advanced tab will appear and resemble the figure shown below.

Print Dialog Box with Advanced Tab Displayed

The “Cover Page” field can be marked to indicate that a cover page should be
provided with the printout.  The blank field beside the check box is used to
indicate the location of the cover page text or graphic file.  The BROWSE button can
be used to search your files for the specific file.
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The “Blank Page” field can be used to allow a specified number of blank page(s)
to be inserted through the printer before and/or after each printed page.

“Print Overflow,” when checked, will prompt the software to print the calendar
information that doesn’t fit in the allotted space.

“Print in black and white” prompts color printers to print a color document in
black and white, which is useful for draft versions.

“Print Facing Pictures” will prompt the software to print any graphics that are
programmed to appear opposite the calendar page.

! Facing pictures are added to your calendar using the View Properties item
on the Calendar main menu.

o Modify the Advanced settings as desired.  When you are finished, apply
these settings by activating the OK button.

TRAYS TAB

The Trays tab is used to enter your printer’s specifications.  Once these settings
have been input, they should not have to be adjusted unless you install a new
printer.

o Select the Trays tab from the Print dialog box item.

The Trays tab will appear and resemble the figure shown below.

Print Dialog Box with Trays Tab Displayed
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Refer to your printer’s user manual for details on the specifications required by
your printer.

! You can use the Tray Wizard feature for assistance in making the
necessary adjustments.

REGULAR TAB

The Regular tab is used to establish the specification when printing multiple
calendars on one page, as well as when printing poster-type calendars.

o Select the Regular tab from the Print dialog box item.

The Regular tab will appear and resemble the figure shown below.

Print Dialog Box with Regular Tab Displayed

This tab allows you to indicate how to format the cutting guides for a regular-
layout document.  It also is used to indicate the printing order of the calendars
(either across or down).
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INSTABOOK TAB

The InstaBook tab is used to determine the cutting and folding guides for
InstaBook-type calendars.

o Select the InstaBook tab from the Print dialog box item.

The InstaBook tab will appear and resemble the figure shown below.

Print Dialog Box with InstaBook Tab Displayed

Print Preview
Calendar Creator provides a print preview feature that can be used to view your
calendars prior to printing them to examine the results of your layout setup.  This
feature works much like the print preview in most Windows-based applications.

o Select the Print Preview item from the File main menu.

The Print Preview screen will appear and resemble the figure shown below.

Print Preview Screen with Sample Layout
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The buttons listed across the top of this sample layout allow you to perform the
following functions:

• print the calendar(s)

• view the next page

• view the previous page

• zoom in to a particular area of the image

• zoom out to full view of the image

• close the preview

o Preview your calendar and make any necessary adjustments prior to
printing by referring to the tabs previously discussed.  When you are
satisfied, close your preview screen by clicking on the CLOSE button.

Printing Your Calendar

Once you have made your print layout adjustments and any other necessary
changes, you are ready to print your calendar.

To initiate printing:

o Select the OK button on the Print Layout dialog box.

Printing on Custom Paper Sizes
Calendar Creator allows you to print to any size paper that your printer can
accommodate.  To set up printing on paper of a custom size, you must first
configure your printer.  (Please refer to your printer or Windows documentation for
the proper procedure.)  Once you have configured your printer to accept the
custom paper size, you must now tell Calendar Creator the specifications of the
custom paper you will be printing on.

M If your printer’s unprintable area is greater than the default page
margin set by Calendar Creator, you will receive an error message
and will be unable to print.

The Page Margin options are used to specify the four margins of your paper.  As you
adjust each margin, the Page preview will also adjust to show the changes.  Consider
the unprintable area of your printer when setting your page margins. You can check
these values by accessing your printer’s properties (see your printer or Windows
documentation).  If the printer’s unprintable area is 1/8” for example, you must set
the page margin to any value greater than 1/8”.
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Event List Printing
You can control the information shown on your Event List when printing, by
adjusting the column headers in the Event List view.  By adjusting the width of the
columns you can select the size of the column when printed, or even remove the
column so that it will not appear in the printout.

Address Book Printing
You can control the information shown on your Address Book when printing, by
adjusting the column headers in the Address Book View.  By adjusting the width of
the columns you can select the size of the column when printed, or even remove
the column so that it will not appear in the printout.

Printing Event Reports
When printing your Event Report, you can specify whether you would like to have
the calendar title appear at the top of each page or on the first page only.  To set
this option, access the Layout Properties dialog box (see Chapter 3, Formatting
Features), and select the Miscellaneous tab.  To show the calendar title at the top
of each printed page, select the “Show Title on Each Page” option.  To have the
title print only on the first page, leave this checkbox unmarked.

To print a 2-Column Event Report, select the Page Layout command under the File
main menu.  Under the Current Layout option, select Event Report 2-Column from
the current layout list.  Select any other print layout options you wish, then click
on OK.

Print Wizard
Calendar Creator offers Print Wizard.  It is a useful tool that assists you in setting
up your print specifications.  It takes you through a basic question and answer
session to determine what type of calendar you want to produce.  In essence, it
steps you through the options that are listed on the tabs discussed in this chapter.
Once you have completed the Print Wizard, you can save your print settings to be
reapplied at any time.

You may want to use the Print Wizard feature to get started.  Then, as you become
more familiar with the unlimited printing options offered by Calendar Creator,
you may want to get creative and try your own settings.

! Print Wizard can be accessed by selecting the Print Wizard item from the
File main menu located at the top of your screen.
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Appendix

Troubleshooting
If you encounter problems or need assistance, please refer to Troubleshooting in
the Read Me file on your Calendar Creator CD.

Try this first!

If you have problems running the program, try cleaning the CD.  Gently remove
any fingerprints and dust using a clean, soft, lint-free cloth dampened with water
or a CD-cleaning solution.  Avoid using material such as tissue, which may scratch
the CD.

Technical Support
If you are unable to solve a problem, contact Technical Support at the following
numbers/addresses.

Direct Telephone 1-423-670-2020

Fax 1-423-670-2021

Internet support@learningco.com

CompuServe GO LEARNINGCO

World Wide Web site http://www.learningco.com

Correspondence The Learning Company
Technical Support
9715 Parkside Drive
Knoxville, TN  37922

Before contacting Technical Support:

• Write down any error messages as they appeared on the screen.

• Be in front of your computer, if possible.

• Have your Windows installation disks or CD available.

• Have only Explorer running.  Close any other running programs,
including Calendar Creator. (See Troubleshooting in your CD booklet,
for instructions on how to close running programs.)

Be sure to register this program so we can provide you with technical support
and notify you of exciting new products as they become available.
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Customer Service

We are proud of the special relationship we have with many satisfied customers
who use our software.  If you have a problem, question, or suggestion, please call
our Customer Service Department at 800-227-5609 (U.S. only) or 617-494-1200
(outside the U.S.).

Damaged Disc Replacement Policy

The Learning Company will replace CDs that the user damages for a duplicating
and handling fee.  Return the damaged CD and a check for $10 to the address
below, marked Attention: CD Return Dept.

The Learning Company
One Athenaeum Street
Cambridge, MA  02142
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Alarms
categories  4.5–4.6
launching an application  4.22
messages  4.22
sounds  4.22

Associating
categories and calendars  4.9
contacts with a group  5.11

Attributes  4.2
Automatic dial  5.5
AutoRun  2.1
AutoSave  3.31

B
Background & border options  3.17
Background programs  A.1
Browse

directories  2.2

for folder  3.13
names list  5.14
picture files  4.7

C
Calendar properties  3.32
Calendar Type indicator  2.5
Calendar views. See Views
Calendar Views tab  3.28
Categories tab  3.27
Cells  1.6, 3.7
Changing

address book information  5.5
an alarm  4.26
calendar dates  3.21
calendar layout settings  6.3
contact or group information  5.11
the start day  3.26

Clip art  2.2, 3.11
Clip Art Properties dialog box  3.11
Color  3.19
Commands and controls  2.3
Contacts. See Participants
Converting DOS files  2.10, 5.18
Creating

a booklet  6.3
a multiple view file  3.26
a new calendar  3.1
an address list  5.1–5.2
an event list  4.1
groups  5.10

Custom
address book  5.12
calendar  3.7
paper sizes  6.13
print layout  6.3
views  3.32

Customer Service  A.2
Cutting and folding guides  6.12

D
Date objects  3.23
Default calendar view  2.2, 3.1
Deleting

a category  4.3
a linked file  2.10
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a QuickStyle  3.6
paper stock  6.5

Drawing objects  1.6, 3.7

E
E-mail information  5.4
Event

add  4.9
alarms  4.21–4.23
categories  4.2
color  4.19
effects  4.15
notes  4.20
pictures  4.17
priority  4.11
query  4.24
text style  4.15
time periods  4.11

Event list  2.7, 4.1, 6.14
Event reports  4.25
Event tab  3.20
Exporting files  2.9
Extruded text  3.19

F
Facing Picture tab  3.30
File main menu  4.27
File sharing. See Network
File types

*.ab5  5.18
*.ca5  3.12
*.cc5  2.9, 3.31
*.csv  2.9, 5.18

Find. See Search
Font dialog box  4.4
Formatting

categories  4.4
notes  3.22
pre-formatted styles  3.5
tabs  3.7

Functions tab  4.19

G
General tab  3.30
Go to today’s date  2.5
Graphics. See Pictures
Group. See Address group

H
Help  1.5

I
Import Fields dialog box  2.10, 5.18
Importing files  2.8–2.9, 5.18
InstaBook, defined  6.2
Installing Calendar Creator  2.1–2.2

K
Keyboard symbols  1.5

L
Launch. See Alarms
Layer order  3.24
Layout Object Properties  3.7–3.8
Line up objects  3.13
Linking files  2.8–2.10, 4.8
Local alarms, defined  4.27

M
Main menu  2.3
Main toolbar  2.3
Margins. See Print Layout: Page tab
Messages. See Alarms
Moveable

cells  1.6
pictures/objects  3.8
text  3.15

Moving between pages  3.25
MS Exchange application  5.11
Multiple calendars  3.26
Multiple views  2.7

N
Naming a calendar file  3.27
Navigation  2.5
Network  2.8
New calendar  3.1
New QuickStyle (fig.)  3.6
Notes  3.22

O
Object tab  3.30
Open dialog box  4.7
Opening files  2.8

P
Page orientation  6.3
Palm Pilot files  2.9
Paper stock  6.4
Participants  4.11
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Phone  5.6. See also Automatic dial
Pictures  3.7–3.11, 4.6
Pictures tab  3.20
Preferences  3.31
Preview. See View Pages
Previous versions  2.8–2.9, 3.31
Print

Advanced tab  6.9
InstaBook tab  6.12
Printing tab  6.8
Regular tab  6.11
Trays tab  6.10

Print Layout
Calendar tab  6.5
Layout tab  6.2
Margins tab  6.6
Page tab  6.3

Print Preview  6.12–6.13
Printer specifications. See Print:

Trays tab
Printing

address book  6.14
advanced features  6.9
background options  3.17
binding margin  6.3
border options  3.17
event lists  6.14
event reports  6.14
graphics  6.10
multiple calendars  6.5
pictures  6.1
poster-size calendars  6.3
setting margins  6.6
time span  6.2

Printing error. See Unprintable area
Printing your calendar  6.13
Properties button  4.3

Q
Query  5.17
Querying your events  4.24
Quick Date  2.5, 4.10
QuickStyles  3.5, 3.27

R
Registering the program  2.2
Removing

contacts  5.6, 5.8
event information  5.8

names  4.12, 5.11
search items  5.17

Repeat occurrence rule  3.21
Repeated events  4.10
Repeats dialog box  4.13
Repeats tab  3.20
Run dialog box  2.1

S
Sample Font dialog box  3.16
Saving a calendar file  3.31
Screen definitions  2.2
Script. See Font dialog box
Search. See also Event: query

address book  5.16
for records  5.17

Selecting
a date  2.5
paper stock and size  6.3
the printer  6.8
your calendar view  3.2

Sending e-mail  5.12
Setting

alarms  4.21
calendar margins  6.7
page margins  6.13
paper size  6.5

Shadow/highlight tab  3.19
Show toolbars  2.3
Size controls  3.12, 6.6
Sorting

address book  5.15
address list  5.1
contacts  5.13
events  4.23

Sound. See Alarms
Special effects  3.18
Split-screen view  2.7
Start date  4.10
Start-up  2.1
Styles

applying to a categoy  4.3
calendar  3.15, 3.27
event  4.14

Submenus  2.3
System requirements  2.1

T
Technical Support  A.1
Text. See Adding: text

Index
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Time period  2.5. See also Printing:
time span

Topic field  3.15
Transparent. See Color
Tray Wizard  6.11
Troubleshooting  A.1

U
Unprintable area  6.13
Updating files  2.10
Using the Scheduler  4.26

V
View, defined  3.1
View main menu  4.27
View Pages. See Print Preview
View Properties  3.29
View type. See Active view

selection
Views

address list  5.2
calendar  3.2–3.3
custom. See Custom: views

W
Web site  5.6
Week start day  3.26
Weekdays only  3.26
Window display  2.7


